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1 I n t r o d u c t i o n

Welcome to Pazzles Creative Cutter!
Congratulations on your purchase of the Pazzles Creative Cutter and on your move to a more 
powerful and creative level of scrapbooking! With the Pazzles Creative Cutter and software, all 
scrapbookers can make cuts and use techniques that once were available only from professional 
diecutters. This computer-driven blade-cut system puts production of custom cuts in your 
hands, without the added costs (often totaling hundreds of dollars) for dies.

To get the most of your cutter, we recommend you spend a few moments becoming acquainted 
with the cutter, the Pazzles Creative Cutter software, and the supplemental Creative Cutter 
learning aids.

Viewing the Creative Cutter Basics Video

The Creative Cutter Basics video provides quick and clear instructions on installing, setting up, 
and using the Creative Cutter. Keep it in a safe place for easy reference if you need to reinstall 
your product later on.

Using This Book

Keep this manual handy as you explore the possibilities with the Pazzles Creative Cutter. We 
recommend that you skim through it to get an idea of what it contains and then follow the 
recommended reading sequence on page 2.
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Recommended Reading Sequence

If you’re very comfortable with Windows® software applications and basic printer 
operation, use chapter 2 to properly install and set up the Pazzles Creative Cutter. Skim 
through chapter 3 and 6. To get the most from the cutter, work through the projects in chapter 4. 
Finally, review the contents of chapters 5, 7, and 8 to acquaint yourself with the techniques you 
can begin incorporating into your scrapbooking projects. 

If you’re more confident in your scrapbooking skills than you are with a computer, we 
recommend you carefully read chapters 2 and 3 first. Then work through all the projects in 
chapter 4.

• Chapter 2 will guide you through proper installation and set up of the Pazzles Creative Cutter. 

• Chapter 3 provides concise instructions on starting the cutter, using the software, and making cuts. 

• Chapter 4 leads you directly through your first projects! In just a few hours, you will master the 
techniques you'll use the most often with the Pazzles Creative Cutter. 

When you are comfortable with the techniques in the early chapters of the book, begin to 
explore the scrapbooking techniques described in chapter 5 and beyond.

Sharing Tips and Ideas

The folks who use the Pazzles Creative Cutter are enthusiastic, knowledgeable, and love to 
share tips and ideas! To join the discussions, get tips and suggestions from other scrapbookers, 
learn about new products, and obtain free fonts and images, visit our website at 
www.pazzles.com.

Contacting Customer Support

Your Pazzles Creative Cutter comes with 35 days unlimited phone support from date of 
shipping (866-729-9537). Following that period, Pazzles provides one year unlimited online 
support from the Creative Cutter support team at www.pazzles.com. After those periods, 
technical support is available from 9:00 am to 3:00 pm Mountain Time Monday–Friday at a rate 
of $25.00 per hour. Before you contact the support team, please complete the following steps.

What to do Before You Contact the Pazzles Support Team

• Check your hardware. Are all cords and connectors on the cutter and your computer fully plugged 
in? Is the cutter connected to the computer?

• If the problem seems to occur with the software, turn off your computer and then restart it. Try the 
operation again.

• Read chapter 8 for troubleshooting tips.

• If the problem is with cutting, check the blade and the mat. See “Working With the Blade” on 
page 14.

http://www.pazzles.com
http://www.pazzles.com
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• If the problem remains after completing these steps, contact Pazzles at www.pazzles.com. Include 
the following information in your e-mail:

• Your name and (if applicable) your company name

• Your TSID number

• A complete description of the problem and if appropriate, the problem file as an attachment. 

Important Information About Your New Cutter

Be sure to read the notices shown in figure 1 and figure 2, which are included in the Creative 
Cutter package.

Figure 1

http://www.pazzles.com
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Figure 2
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2 I n s t a l l a t i o n  a n d  S e t u p

Contents of the Creative Cutter Package
Before you begin to install and set-up the Creative Cutter, unpack the shipping package and verify you 
have all parts and pieces.
• Pazzles Creative Cutter Instruction Manual (this book)

• THE FOLLOWING CD’S ARE ALL COMBINED ON ONE CD SEE figure 3 .

Figure 3

*Creative Cutter “The Basics” Tutorial (CD)

*CD Set 1 (CD’s 1-5) Over 1000 Images Ready to Cut!

*CD Set 6 (CD’s 20, 28-31) Over 1000 Images Ready to Cut!

*Sampler Image CD

*Journaling Fonts CD

• Creative Cutter “Beyond the Basics” Tutorial (CD)
• Creative Cutter Pro Machine
• Gray Serial Cord (1)
• Black Power Cord (1)
• Red-cap blades (2) (primarily used for cutting vinyl and lighter weight papers.) May be used as an “emergency” blade 
for paper and cardstock.
• Blade Holder with Blade Properly Inserted (1 Blue Tipped 60 Degree Blade)
• Cutting Mat (2) 
• Fabric Mat (1)
• Embossing Mat (1)
• Pazzles Creative Cutter 2005 software (CD) (1) with Training CD (1)
• Starter Strip (1) (installed on the cutter)
• Front and Back Trays
• Creative Cutter Window Cling
• Set-up Card
• Pen Tool with 2 Saukura Gel Pens
• Sample Paper Pack 
• 7 Piece Tool Kit
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Installing the Software
Follow these instructions to successfully install and configure the Pazzles Creative Cutter 
software.

Installing and Starting the Software

1 Insert the Cutting and Design Software for the Creative Cutter into your CD-ROM.

The installation program should begin automatically. 

2 To install the software, click Install Letter 2005.

3 When you are prompted to enter a password, type pazzles.

Setting up the cutter

Attach the Cutter to the Computer

1 Verify the cutter is placed on a sturdy, flat surface that can withstand the weight of the 
cutter.

2 Connect the power cord. See figure 4.

Figure 4
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Connect the cutter to your computer. The large end attaches to the right side of the cutter, 
and the small end attaches to your computer’s serial port see figure 5.

Figure 5

NOTE: If you do not have a serial port, see “What To Do If You Don’t Have a Serial Port” on 
page 9.

What To Do If You Don’t Have a Serial Port

Some computers do not have a serial port or do not have one available for use with the Creative 
Cutter. In that case, please use the following option:

• Purchase a USB to Serial converter (under $50) at any computer store. DO NOT purchase a USB 
to Parallel converter, which is for PRINTERS only and will not work with the Creative Cutter. 
Connect the adapter to your computer first, and then install the software that comes with the converter. 
Be sure to select a COM port when setting up the cutter driver settings. Then, complete the steps that 
follow.

• Although there is a parallel connection on the cutter, using the parallel connection rarely works 
and Pazzles does not recommend using it.

Determine the Port the USB to Serial Was Assigned To

Complete these steps after installing the USB to Serial converter. In a store bought USB to 
Serial Converter, you will need to follow the manufacturer’s instructions.

1 Go to Start at the bottom-left corner of your screen and click on it.

2 Find My Computer and right-click on it. When you do, a menu opens.

3 Click Manage.

4 Click Device Manager.

5 Click Ports to view a list of ports.

6 From the list of ports, look for a USB Serial Port. Take note of the port number assigned to 
it. You will use that port number when setting up plotter codes in the program. If the number is 
higher than 6, you must change it. Use the “Change the Port number” procedure that follows.
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Figure 6

Change the Port Number

Use this procedure if the port number is higher than 4.

1 Double-click on the port to open the Port Properties screen.

2 Click the Port Settings tab.

3 Click the Advanced button.

4 Look for the COM Port Number window.

5 Click the arrow to display available ports. Ports that are unavailable are marked “In Use.”

6 Choose an available port with a number 1,2,3, or 4 and click OK. 

7 Use the number to set up plotter codes.

Install the USB Security Key (Hardlock)
1 Insert the USB Key (the black key with a green light on one end that says ROCKEY2 in 
white lettering). See figure 7. You can find your key in the case that has your software. It is 
titled Cutting & Design Software for the Creative Cutter.
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Figure 7

2 This key will install automatically.

WARNING! This key must be inserted at ALL times when the program is in use! This key 
must also be inserted into the SAME USB port on your computer that it was installed on 
originally, otherwise you will encounter an error when trying to open or operate the program!

Setting Up the Software
1 Start the Creative Cutter Program by double clicking on the Creative Cutter Icon on your 
Desktop. See figure 8.

Figure 8

2 When the Start Up window (figure 9) opens, press the ESC key on your keyboard. The 
Welcome screen opens. 

Figure 9
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3 Click the left-most image on the Welcome screen to open the Sign page box.

Figure 10

4 In the Page box, type the dimensions of the size of paper you plan to cut. For now, type 12 
in the Length and Height boxes, and then click OK. The page dimensions you typed are saved 
for use in the future, and the Workspace screen opens. See figure 10.

WARNING! If the Security Key is not in place, the program will shut down!

Configuring Toolbars and Software Settings

1 Click the View menu on the Pazzles Creative Cutter screen, and then click Toolbars. 
(Toolbar selections determine the toolbars that appear when you open Pazzles Creative Cutter.)

2 Click each of the following options to select them: Standard bar, Tools bar, Selection 
bar, Manipulation bar, Zoom bar. The toolbars you select are marked with a checkmark. 

Figure 11

3 From the View menu, click Grid to select it. Turning on Grid is helpful in placing images 
by displaying small dots at 1-inch intervals on the Page screen.

4 Click the Settings menu, and then click Grid to open the Setting box.

5 In the Setting box, click the Unit/Page tab.
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6 Under Unit of measurement, click inches.
TIP: You can change the Toolbar and Grid settings at any time.

7 Click the Vectorization tab, and then click the Make Clean box to check it.

Figure 12

Unless you reinstall the software, you should not need to make further changes to the 
Vectorization settings.

Select the Plotter

1 Open Pazzles Creative Cutter.

2 Click Settings, and then click Plotter Codes. When you do, the Setup Plotter box opens.

3 Click Add/Remove and then select Creative OM_40 from the list of Active Plotters. 

4 Click Accept/Save.

Select the Port

• (Serial port) Try a test cut. (See “Determine the Port the USB to Serial Was Assigned To” on 
page 9.) 

• (USB to Serial converter) In the Port box, click COM port and then select the one assigned (see 
“Determine the Port the USB to Serial Was Assigned To” on page 9). Try a test cut. (See “Determine 
the Port the USB to Serial Was Assigned To” on page 9.) 
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Working With the Blade

IMPORTANT: The cutter is delivered with the blade inserted properly 
into the blade-holder unit. 

Characteristics of Properly Installed Blades

Take note of how far the blade is installed in the casing—a properly-installed blade is barely 
visible. When you replace the blade, be sure to push it in so that slightly less than 1mm (about 
1/32") of the blade can be seen or felt.

Many factors affect the life of your blade. 

• The weight of the paper being cut.

• The composition of the paper being cut.

• The experience of the person doing the cutting. The life of your blade will improve commensurate 
with the improvements to your technique that come with practice.

Proper adjustment and correct pressure will ensure you derive maximum longevity out of your 
blade.

Replacing the Blade 

Blades should be replaced when any of the following conditions occur: 

• Cut quality suddenly gets worse.

• You must continue to increase pressure to get clean cuts.

• The corners and tight turns do not cut cleanly or are pushed in.

NOTE: This condition can also be caused by using too much pressure.

Use the following procedure when it is time to replace the blade.

TIP: Be sure to remove the yellow or red cap from the blade before inserting.

1 For most common cutting tasks, choose the blade with the yellow cap. (Use the red-capped 
blade as a back-up blade or for vinyl and lighter weight papers)



Chapter 2 Installation and Setup

Creative Cutter PRO 15

2 Loosen the gold washer from the blade casing and then remove the silver bladeholder from 
the blade casing. See figure 13 this depicts the Blade Holder together, and in pieces.

Figure 13

3 Insert the blade into the silver holder as far as it will go. To avoid puncturing your skin on 
the blade, push the blade with your fingernail. 

4 Screw the bladeholder into the black plunger until the blade is barely visible and can barely 
be felt. 

5 Use the blade positioning guide show in Figure 14 to check the position of your blade. Place 
the blade next to the picture; the blade in the picture and your blade should match. Due to paper 
thickness and characteristics of individual machines, you may need to make minor adjustments 
after installing a new blade..

6 Tighten the gold lock nut to hold the blade in place. 

TIP: Keeping the silver bladeholder still while you tighten the gold washer can be tricky and 
might take some practice. See figure 14 to compare.
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Figure 14

7 Loosen the thumbscrew on the blade carriage (the black box that slides on the silver rail). 
Insert the blade unit into the front opening of the blade carriage. See page 17, and figure 16.

Figure 15

8 While supporting the carriage with a finger, push in the bladeholder. When the blade-holder 
unit is inserted as far as it will go, tighten the screw.

IMPORTANT: Your blade holder needs to be inserted in the front hole of the blade 
carriage see figure 16 on page 17. Use the hole that is circled.
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Figure 16

Working With the Cutting Mat
The cutting mat helps the paper travel smoothly through the cutter. As with the blade, proper 
use and care of the cutting mat will increase the quality of your cuts and the life of the cutter. 

IMPORTANT: Using a cutting mat beyond its useful life will result in poor-quality cuts. For 
tips on using and caring for your mat, see “Tips for Getting the Most From Your Blade and 
Mat” on page 20.

The two pinch rollers hold the mat place in the cutter, as shown in figure 17. Each pinch roller 
is composed of three parts: .

Figure 17

• A box-like housing that features a yellow triangle used for verifying the alignment of the pinch 
roller in the cutter 

• Two hubs (wheel supports) on either side of the roller

• The roller, which is located between the two supports
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Pazzles Logo Mats.

Figure 18

9 Please take off your clear protective cover sheet before putting the paper on the mat. See 
figure 19 

Figure 19

10 Place your paper on the mat inside the blue border, on the sticky part of the mat. See 
figure 20 .

Figure 20
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11 Smooth your paper on the mat. See figure 21 .

Figure 21

12 See figure 22 for details on how to position your pinch rollers properly.

Figure 22

13 Put mat into cutter when you are ready to cut. When inserted, the bulk of the mat should 
extend out the back of your cutter. See figure 23 .

Figure 23
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IMPORTANT: The left pinch roller must always be lined up with one of the black triangle 
stickers (A.). The right pinch roller must always remain in the area of the black and yellow 
stripe (B.). See figure 23  on page 19.

• On the left and right sides of the paper, be sure that the inner hub (the one closest to the paper), 
tracks on the outside edge of the paper.

• On the front side of the mat, line up the front edge of the mat with the front edge of the cutting 
strip.

14 Press F4 watch for the size displayed on the Cutting Control Panel. True 12x12 papers 
should display as approximately 305-310mm. If a different number appears and exact centering 
of images on the page is important, remove the paper, measure it, and enter its true size on the 
workspace size field in the Pazzles Creative Cutter software. When the displayed size is correct, 
you are ready to make the cut.

Tips for Getting the Most From Your Blade and Mat

Caring for the Cutting Mat

When cared for properly, the adhesive on the cutting mat has a useful life of about 50-100 
passes through the cutter. To get the best results from your mat, follow the care and useage 
guidelines.

CAUTION: The Pazzles Logo Mats CANNOT be recovered. Once they are worn out, you must 
replace the entire mat and throw the old one away.

• Do not over-extend the blade. You should barely be able to see or feel the blade.

• Use proper pressure when cutting.

• Store the mat flat and covered with protective sheet.

IMPORTANT: If you see heavy score marks in the adhesive, your blade is out too far or the 
pressure is too great.

NOTE: Humidity affects tackiness on the mat!

Care and Usage Guidelines for Cutting Mats

• Cover the cutting mat with the clear sheet that covers the mat when you are not using it.

• Always store the cutting mat flat.

• If oil from your hands gets on the the mat, try to remove it with a lint roller or masking tape.

• Scrape bits of paper off the mat, using a scraper or old credit card.
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• If lint or dust accumulates on the mat, try to remove it by patting rolled up packing tape over the 
mat.

• Rotate the mat as you use it. To prevent warping, alternate sides and shift the paper away from the 
edge.

• If a new mat’s tack is too strong, pat the mat with your hands or with a piece of cardstock to dull 
the tack. Tack will lessen with use.

• If your pinch rollers routinely come into contact with the mat and become sticky, use UNDU 
adhesive remover on a toothbrush to remove the adhesive buildup. 

How to Tell When You Need a New Mat

• Your mat is warped, heavily scored, or won’t lie flat.

• You have a new blade and your cutting quality is poor overall.

• Your design cuts fine in some places but not in others.

• Your mat no longer holds paper.

IMPORTANT: Using a cutting mat beyond its useful life will result in poor-quality cuts.
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3 B a s i c  P r o c e d u r e s  f o r  U s i n g  
t h e  C r e a t i v e  C u t t e r  P r o

Introducing the Cutting Control Panel
The Cutting Control Panel plays an important role in the success of your cutting projects. It’s 
important you are familiar with the Cutting Control Panel and the settings you will apply to it. 
Refer to the information in this section as you use the cutter. See figure 24.

Figure 24
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Settings for the Cutting Control Panel

Material

Usually set Material to 12.00. Change the setting if you are cutting wider paper. For example, 
when cutting 15" paper, change the setting to 15.00.

Pressure

Set between 10 and 495.

Advance

Leave clear (not checked).

Vinyl Size

Shows the position of the object on the page.

ZoomTools

Enables zooming in and out while within the cutting mode.

Color Boxes

Enables you to select which line color to cut.

Panels

If 101, 102 appears, indicates that your project is too big for the paper.

Starting and Using the Cutter

IMPORTANT: Before you begin, verify all software and hardware is installed and configured 
correctly. See chapter 2 and the previous section for details.

Step 1: Start the Cutter

1 Turn on cutter by pressing the rocker switch on the left side of the machine.
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2 Raise the pinch rollers by turning the black wheel on the right side of the cutter. (To locate 
the pinch rollers, look for the yellow triangle at the top of each roller.)

Figure 25

3 Position the paper horizontally on the mat with the top of the page rotated 90 degrees to the 
left. See figure 26.

TIP: Because the cutter cuts the top of the page on the left side of the machine, place the top of 
the paper on the left side of the mat. 

Figure 26

4 Insert the mat into the cutter. For detailed information, see “Pazzles Logo Mats.” on 
page 18. 
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TIP: If an Out of Pinch message displays on the Cutting Control Panel, check the alignment of 
the pinch rollers. The pinch rollers must align with a yellow arrow and the yellow bar.

Figure 27

5 Lower the pinch rollers by turning the black knob on the right side of the machine towards 
you. Stop turning when the control panel displays the following message: 

Figure 28

6 Press F4 on the control panel until the panel message reads “Checking Size.” This means 
the cutter is measuring the width of the paper. 
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7 Press F1 until the control panel displays the message CUT 4, which is the paper-cutting 
mode. 

Figure 29

Step 2: Start the Software

1 Open Pazzles Creative Cutter (see “Installing and Starting the Software” on page 8).

2 Click the left-most image on the Welcome screen to open the Sign page box.

Figure 30

3 Type the exact length and height of the paper you are cutting in the appropriate boxes and 
then click OK. 

4 On the Pazzles Creative Cutter menu, click Draw and then click Circle. When you do, the 
cursor changes to a plus sign.

5 In the blank page on your screen, click the cursor about one inch inside and down from the 
upper-left corner.
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6 Hold down the mouse and drag the cursor to draw a circle about the size of a quarter. Your 
screen should look similar to this: 

Figure 31

Step 3: Make the Cut

1 Position the paper onto the mat and load it into the cutter. For test cuts, use lightweight 
(65 lb.) paper. For detailed instruction on loading the paper, see “Pazzles Logo Mats.” on 
page 18. 

2 On the Pazzles Creative Cutter menu, click the Cut Panel icon to open Cutting Control 
Panel window.

Figure 32

3 On the Cutting Control Panel window, make the following selections:

 For this option  Make this selection  Notes

Cutting speed Slowest As you gain experience with the cutter, 
increase the cutting speed. The maximum 
recommended speed is MED.

Advance Clear the box Clear any boxes that are checked.

Pressure 145–165 (for 65 lb. 
paper)

See “Tips for Determining Proper Pressure” 
on page 30.
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4 Verify that the wheels are lowered and that you have measured the paper (see Step 1, #4 on 
page 25) and are using CUT 4 mode.

5 On the Cutting Control Panel, click Start to initiate the cut. If cutting does not start, see 
“Setting Up the Software” on page 11.

6 Examine results; continue to test various pressures until the cut is satisfactory. For more 
information, see “Tips for Determining Proper Pressure” on page 30.

Change the Page Size 

1 Click Setting from the menu bar at the top of the screen.

2 From the Setting menu, click Page. See figure 33.

Figure 33

3 Change the page size. See figure 34. 

4 Click OK.

Figure 34
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Tips for Determining Proper Pressure

The way the blade is inserted in the blade holder, various types of papers, and differences in 
humidity and blade length can all affect the pressure required for a good cut. Although the 
pressure setting is usually between 100 and 350 gms, it can go as high as 495. Use these tips to 
determine the pressure needed for successful cutting.

• You must test for proper pressure each time you replace the blade.

• Pressure is too high if the blade deeply scores the mat or if the paper bunches up and tears. 

• Pressure is too low if the paper does not cut completely.

• If you are cutting 65 lb. paper and require pressure under 135 for a good cut, it is possible that the 
blade is out too far. Reinsert the blade so that it is barely visible and can barely be felt, and then 
increase the pressure.

• Once you determine a good pressure for 65 lb. (light cardstock) paper, use that pressure as a 
baseline for other types of papers. For example, if a pressure of 165 works well for 65 lb. (light 
cardstock) try 90-110 for text-weight paper and 185-225 for heavy-weight paper.

• You will develop a “feel” for the right pressure with experience. Don’t be afraid to experiment to 
see what works best.

WARNING! While you are learning how to use the cuter, refrain from trying to cut heavy 
cardstocks and fibrous papers. Practice using smooth medium weight (65 lb) cardstocks and 
text weight papers. Keep in mind that fibrous paper will drastically shorten the life of your mat 
and your blade.

Fixing Problems That Occur During Cutting

WARNING! If you experience a problem, do not yank the paper out and do not force the 
carriage to move. If necessary, turn off the cutter to remove the paper and move the carriage. 

TIP: For more troubleshooting techniques, see “Troubleshooting Guide” on page 139.

Canceling a Cutting Job

If something goes wrong while you are cutting, use the following procedure to cancel the 
cutting job and start again.

1 Press the Pause button on the Cutting Control Panel to stop the cutting job.

2 Simultaneously press both the RESET and the ENTER buttons on the Cutting Control 
Panel. When you do, the control panel screen displays “Reset cutter?”.

3 Click F2 (Yes) to reset the cutter.

• If the cutter resets, restart the cutting job. Be sure to press the F1 button to set the cutting mode 
to CUT 4.

• If the cutter does not reset, turn off the cutter, wait about 45 seconds, and turn it back on again. 
Then, restart the cutting job.
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HPGL Error 

If an HPGL Error message appears, try the following procedures to clear the error and start 
again.

• If the error appears when you stopped the cutting process, press the NEXT button on the cutter.

• If pressing NEXT does not work, turn off the cutter, wait a few minutes, and turn it back on again. 

• If the error appears after re-starting the cutter, check the pressure setting. Pressure settings cannot 
exceed 500.

• If the error continues to display, check all connections between the cutter and the computer.

Cutter Starts to Cut Poorly

If the cutter was working fine and then seems unable to cut through paper, try these procedures:

• Increase the pressure setting. Pressure can be set as high as 495. See “Tips for Determining Proper 
Pressure” on page 30.

• Try reducing the pressure. Using too much pressure can cause poor cuts, especially in tight 
corners.

• Press down several times on the silver tip of the blade holder. Do this while the blade is inserted in 
the carriage. Sometimes a minuscule piece of paper or dust can keep the mechanism from moving 
freely.

• Re-insert the blade. Blades occasionally move a slight bit in the blade holder, and even the tiniest 
change can affect pressure.

• Clean the mat. Scrape off any bits of paper and remove bits of lint.

• Are the cutter platforms installed? The platforms prevent the mat from drooping which will cause 
poor cutting especially at the edges of the mat.

• Replace the mat. It might be warped or have too many layers of adhesive.

• Replace the blade. It might be worn from use, it might be damaged from a paper jam or from 
cutting heavy or unusual material, or it might be defective.
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4 C r e a t i v e  C u t t e r  T u t o r i a l s

The four projects in this chapter provide you an opportunity to learn all the Creative Cutter 
techniques you’ll use the most—and each project takes less than an hour to complete!

All projects assume you have already installed and set up the cutter and the cutter software. 
If not, return to chapters 2 and 3.

Tutorial 3 and Tutorial 4 use advanced skills and can be completed in any order after you are 
comfortable with the skills taught in Tutorial 1 and Tutorial 2.

Tutorial 1: Import a Graphic File, Add a Shadow Mat, 
and Fill a Page With Multiple Iimages 

Import the Graphic File and Open the Software Program

Step 1: Insert the Images CD
1 Insert the CD shown (figure 35) into your computer’s CD-ROM drive.

Figure 35
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If the window shown in figure 36 opens, click the red X to close it.

Figure 36

Step 2: Open the Pazzles Creative Cutter Program

1 Double-click the icon your desktop screen. See figure 37.

Figure 37

2 Press the ESC key on your computer keyboard when you see the Welcome screen.

3 In the next window. Click the Create New Document image. See figure 38.

Figure 38
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Find and Import an Image

1 In your Pazzles Creative Cutter program, click on FILE on the top left corner.

2 From the list select IMPORT, then click on IMAGE from the list that pops out to the right.

3 Locate your CD drive under My Computer. To see all locations on your computer, click the 
arrow by the Look in: My Computer box. See figure 39.

Figure 39

4 Double-click on the CD drive.

5 Double-click on the sampleprojects05 folder. See figure 40.

Figure 40

6 Select any file by clicking on it. For this project, we are using a file called Butterfly05. 

Figure 41

7 Click Open.The image you selected appears on an 12x12 page.



Chapter 4 Creative Cutter Tutorials

36 Creative Cutter PRO

Create a Shadow Mat for the Image
1 To apply changes to an image, you first must select the image. To do that, click Tools on 

the menu bar at the top of the screen, and then click Select All. See figure 42.

Figure 42

2 Small boxes surround the image to show it has been selected. Click Tools again and then 
click Outline to open the Transformation box. See figure 43.

Figure 43

3 Make the following selections in the Transformation box:

 For this setting  Enter this 
value  Notes

Thickness 0.08 In most cases, widths are between 0.02 and 0.10.

Number 1 The Number setting specifies the number of 
outlines. Three is the maximum possible.

Outline Click the box to 
select it.

Unless you are outlining text, leave all other 
boxes blank. If you are outlining text, click 
Break Text.
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TIP: To change a selection, click the Undo button .

4 When you are finished making selections, click the yellow check mark at the lower-right of 
the Transformation box. As shown in figure 44, the color of the image’s outline changes to the 
color you selected.

Figure 44

Multiply the Image and Fill the Page

Step 1: Select and Position the Image

Use the Select Elements tool to select both the butterfly image and its outline. 

TIP: Select Elements is the tool you will use the most. 

1 To select the image and the outline, hold down the mouse button as you drag the mouse to 
the right and down to create a box around the entire image. Drag a big box to be sure that the 
entire image can fit inside. Imagine you are throwing a net around the image to catch all the 
parts. See figure 45.

Figure 45
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2 Release the mouse button. When you do, little boxes appear around the image to show it has 
been selected, as shown in figure 46.

Figure 46

3 To move the image, move the mouse over it until the cursor changes to the Move icon, 
which looks like two crossed arrows. See figure 47.

Figure 47

4 Click the mouse button, hold it down, and drag the image to the location where you want to 
place it on the page. For this project, place it about 0.5 inch down and 0.5 inch from the left. 
Your page should resemble figure 48.

Figure 48

5 Resize the image. Using the Select Elements tool, click one of the corner boxes. Then, hold 
down the mouse button and drag it in or out to resize the image. 

Step 2: Multiply the Image and Fill the Page Across

1 Make sure the image is still selected (it should be surrounded by little black boxes) If it is 
not selected, click Tools and then click Select All to select it.

Click a corner box to resize the image.
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2 Right-click on the screen. On the menu that opens, click Multiply.

Figure 49

3 In the Number box on the Multiply selected elements window, type the number of copies 
needed to fill the page across (side-to-side).

.

Figure 50

4 Set spacing values or leave the settings as-is.

5 For Copy direction, click the right-pointing arrow.

6 Click OK. The images appear across the page, as shown in figure 51.
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TIP: If you make a mistake or must change the number of copies, click the Undo button .

Figure 51

Step 3: Multiply the Image and Fill the Page Down

1 Go to the Tools menu and click Select All. Small boxes surround the images on the page, 
showing that all of them are selected. (If you prefer, you can use the Select Elements tool to 
select all the images on the page. Click the tool and then use it to drag a box around all of the 
images.)

2 Right-click on the workspace and click Multiply on the menu that opens.

3 Type in the number of rows you think will be needed to fill the page.

4 Click the down arrow for Copy direction.

Figure 52
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5 Click OK to fill the page with the image, as shown in figure 53.

Figure 53

TIP: If you have too many or not enough images, click Undo  and start over.

Cut the Project

Step 1: Prepare the Cutter and the Paper

1 Place a 12x12 paper on the cutting mat. 

2 Check that the arrow on the left pinch roller is lined up under the left arrow sticker on the 
cutter. If it is not, do not adjust the left roller. Instead, move the paper under the roller to the 
proper position. See figure 54.

TIP: The right roller can be adjusted to any place within the area represented by the yellow and 
black stripe. This allows for different-sized papers.

Figure 54

The blade carriage can be pushed 
out of the way. Just slide it all the 
way to the right.
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3 Verify that the front edge of the paper is 1 inch in front of the rollers. This will align the 
mat along the front of the green cutting strip on the cutter.

4 When the paper is positioned correctly, turn the black wheel, (located on the right side of 
the cutter) towards you. This lowers the rollers so they can hold the paper as it moves.

5 Turn the Creative Cutter on, using the rocker switch on the left side of the machine. Wait 
for the machine to initialize. It is ready when you see the screen shown in figure 55.

Figure 55

6 Press the F4 button (next to the word SCRAP). The machine then measures the paper by 
moving across and back again.

7 Verify that the next screen looks like figure 56. If CUT 1 is in the upper-left corner of the 
window, press F1 until you see CUT 4. The Creative Cutter is now ready to cut the project. 

Figure 56

TIP: CUT 4 is the paper-cutting mode. If your cuts are not clean, check this setting. 

IMPORTANT: Properly positioning the paper is very important. Study the instructions in the 
previous sections carefully to prevent cutting off the tops of your projects.
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Step 2: Make the Cut

1 Open the Cutting Control Panel (figure 24 on page 23) by clicking the Cutting Control 
Panel icon.

2 Make the following settings on the Cutting Control Panel.

3 Press Start to begin cutting.

• If the cut is good: Hooray!

• If you are unhappy with the cut, insert another piece of paper, adjust the pressure up or down, 
and cut again. 

Pressure Adjustments

• If the blade cuts all the way through but the stop and start points do not meet OR the paper is 
bunched up in the corners, the pressure is too high. Decrease it.

• If the blade does not cut through the paper, increase the pressure.

IMPORTANT: Do not be afraid to raise the pressure. It is perfectly acceptable to cut some 
cardstocks at 375.

 For this setting  Enter this value  Notes

Speed Slowest Start with the slowest when first learn-
ing. Most projects will be done on 
slow or medium.

Panels Leave blank If you see 101, 201, your project is 
larger than 12x12.

Material Use 12.00 for all papers that 
are 12” and under.

Reflects the size of your paper.

Pressure For medium-weight 
cardstock, try 185. 

Depends on the thickness of your 
paper and the blade length. 

To change the pressure, highlight the 
number and type in the new pressure.

Advance Leave blank. If the box is checked, clear it.

Color Select boxes Click the black box. Selects only the black cutting lines



Chapter 4 Creative Cutter Tutorials

44 Creative Cutter PRO

Cut the Shadow Mat

Step 1: Cut the Shadow Mat Pieces

1 Put another piece of paper on the cutting mat for the shadow mats.

2 Insert the mat with paper into the cutter. See “Cut the Project” on page 41.

3 Open the Cutting Control Panel by clicking the Cutting Control Panel icon. 

4 On the Cutting Control Panel, click the red box to select Shadow/Outlines. 

5 For Speed, click Slowest.

6 For Pressure, if you are using the same weight paper, keep the pressure the same as the 
previous cut.

7 Click Start.

Step 2: Separate the Shadow Mat From the Image (Optional)

1 Click the Select Elements tool.

2 Right-click on the workspace and click Color Selection from the menu.

TIP: Turn Color Selection off by de-selecting it in this menu.

3 Click directly on the outline. When you do, everything in that color is selected.

4 Move the arrow over the image until the arrow changes to a cross (the Move tool).

5 Click and hold down the mouse button as you drag the outline away from the image.

Congratulations: you’re done!
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Tutorial 2: Create a Title With Connected Letters, Add a 
Graphic, and Create a Shadow

Create your title

Step 1: Prepare the software

1 Open Pazzles Creative Cutter. See “Step 2: Open the Pazzles Creative Cutter Program” on 
page 34.

2 Click the Create New Document image. See figure 57. 

Figure 57

3 Set up to cut a 12x12 paper.

Figure 58

TIP: These measurements will be saved in the Recent pages window so that next time you can 
easily select this size.
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4 Your workspace should look like this:

Figure 59

5 Verify you have the most-used toolbars selected. To check, click the View menu, and then 
click Toolbars. Select Standard, Tools, Manipulation, Selection and Zoom.

Step 2: Type the Title

1 To type a word, first click on the Text tool .

2 The rectangle on the workspace represents the paper. Click within the rectangle to select a 
location, and begin typing the word. A black line appears where you clicked on the page.

Figure 60
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3 Type the word Summer.

Figure 61

4 Click the Select Elements tool.  It appears as a black arrow on the screen.

TIP: You will use the Select Elements tool often to select objects and to move them.

5 Click the word with the Select Elements tool. Small black squares appear around the word 
to indicate that it is selected:

Figure 62

TIP: When you click on a typed word, the whole word is selected, not just the letter you 
clicked on.

6 Choose a different font. Start by clicking the Font icon. 

7 Click the Cutting button and scroll through the font 
choices until you find Brush Script.

8 Type 2 in the Height box and then click OK.

Figure 63

TIP: Click the TrueType button to see all the fonts you have installed on your computer!
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Step 3: Connect the Letters
1 To make it easier to see your work, zoom in on the word. To 
do that, find the Zoom toolbar and click the Zoom Selected 
icon. See figure 64. 

Figure 64

TIP: Make sure your word is still selected. 
Click on the word with the Select Elements tool. 

2 Click Text in the menu bar at the top of the screen.

Figure 65

3 From the Text menu, click 
Visual Text Spacing. 

Figure 66

Note that there 
is an arrow 
pointing to the 
right. There 
are also small 
boxes below 
each letter.

Figure 67
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4 Click the arrow 
pointing to the right. 
Then, hold down the 
mouse button and 
drag the arrow to the 
left. Watch how the 
little boxes move as 
you drag the arrow.

Figure 68

5
Release the mouse button 
and watch as the letters 
move to the location 
represented by the little 
boxes. See figure 69.

Figure 69

6
To weld the letters into one 
complete word, the letters 
must overlap as shown in 
figure 70. Continue to 
adjust your word by 
moving the arrow left or 
right until your word looks 
like the one shown.

Figure 70

TIP: You can adjust individual letters by selecting the box below a letter and moving it with 
your mouse.

7 Click the Select Elements tool  and then click the word to select it.
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8 Click on Tools and select Welding. 
The overlapping letters weld together.

Figure 71

Figure 72

Congratulations! You just made your first title!
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Cut Your Title

Step 1: Select the Inside and Outside Part of the Word

TIP: Before typed text is welded, you can select it by clicking anywhere on the word. All parts 
inside and out will be grouped together with one click. After you weld the word, the inside and 
outside parts are separate and you must select both the inside and outside parts. Be sure to 
select all the parts. If you don’t, you will leave pieces behind when you move the word.

1 To select both the inside and outside parts 
of your word, click on the Select Elements tool. 

2 Click a spot on the workspace that is above and to the left of the word. Hold down the 
mouse button as you drag the mouse to the right and down to create a box around the entire 
word. 

TIP: Drag a BIG box! You must drag a box big enough to fit the entire word inside. Otherwise 
you may not get all the parts.

Figure 73

3 Position the word: 
To move: Move the mouse over 
the word until the arrow 
changes into a cross symbol. 

Place the word approximately 
1" down from the top and 1" in 
from the left side of he page. 
Click the mouse button, hold 
button down, and drag the 
word to the proper location on 
the page.

Figure 74

Release the mouse button and little 
boxes will appear around the word to 
indicate it is selected.

Tip: Think of this as throwing a net 
around the word to catch all the parts.

Click here
X

move symbol
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4 Place a 12x12 paper on the cutting mat.

5 Insert a 12x12 paper (on mat) into the Creative Cutter. Make sure that the arrow on the left 
pinch roller is lined up under the left arrow sticker on the cutter.

TIP: You usually do not need to adjust the left roller. Move the paper under the roller to the 
proper position.

TIP: The right roller can be adjusted to anyplace within the area represented by the yellow and 
black stripe. This allows for different size papers.

Figure 75

6 Verify that the front edge of the mat is aligned with the front of the green cutting strip.

7 Once the paper is positioned properly, turn the black wheel located on the right side of the 
cutter towards you. This lowers the rollers so they can hold the mat as it moves.

8 Turn the Creative Cutter on, using the rocker switch on the left side of the machine. Wait 
for the machine to initialize. The machine is ready when you see the screen shown in figure 76.

9 Press F4 (next to the word SCRAP). The machine then measures the paper by moving 
across and back again.

Figure 76

10 The next screen should look like figure 77. If Cut 1 is in the upper-left corner of the 
window, press the F1 button until you see CUT 4.

The Blade Carriage can be pushed 
out of the way. Just slide it all the 
way to the right.
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TIP: CUT 4 is the paper cutting mode. If your cuts aren’t clean, verify that you didn’t skip 
step 10 on page 52.

Figure 77

The Creative Cutter is now ready to cut the project.

TIP: Proper positioning of the paper is VERY important! Study these instructions carefully to 
prevent cutting the tops off of your projects.

Step 2: Make the Cut

1 Open the Cutting Control Panel by clicking the Cutting Control Panel icon. 

2 Make the following settings on the Cutting Control Panel.

 For this setting  Enter this value  Notes

Speed Slowest Start with the slowest when 
first learning. Most projects 
will be done on slow or 
medium.

Panels Leave blank If you see 101, 201, your 
project is larger than 12x12.

Material Use 12.00 for all papers that 
are 12” and under.

Reflects the size of your 
paper.

Pressure For medium-weight card-
stock, try 185. 

Depends on the thickness of 
your paper and the blade 
length. 

To change the pressure, 
highlight the number and 
type in the new pressure.

Advance Leave blank. If the box is checked, clear 
it.
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3 Press Start to begin cutting.

• If the cut is good—Hooray!

• If you are unhappy with the cut, close the Cutting Control Panel window and go back to Step 3. 
Move the title to another spot on the page.

TIP: If the blade cuts all the way through but the stop and start points don’t meet OR the paper 
is bunched up in the corners, the pressure is too high. If the blade does not cut through the paper 
increase the pressure.

TIP: DO NOT BE AFRAID TO RAISE THE PRESSURE! It is perfectly acceptable to cut 
some cardstocks at 375.

Add a Graphic to the Title

Step 1: Prepare the Software

1 Close the Cutting Control Panel window by clicking on the red X.

2 Do not close the Summer page. You will be adding a graphic to the word.

3 Insert the Sample Cutting Images CD into the CD-ROM drive of your computer.

Figure 78
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4 If the window shown in figure 79 opens, click the red X to close it.

Figure 79

Step 2: Import a Graphic

1 Click File at the upper-left corner of the menu bar at the top of the Win PCSIGN screen.

Figure 80

2 Click Import then IMAGE.

Figure 81
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3 Find your CD drive under 
MY COMPUTER.

Figure 82

TIP: Click on the arrow button by the window to see more locations on your computer.

Figure 83

4 Double-click on the CD drive.

5 Double-click the sampleprojects05 folder.

Figure 84

6 Double-click the Summer Sun05 file.

Figure 85
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The Summer Sun image then appears on the page, as 
shown in figure 7.

Figure 86

Step 3: Move and Edit the Graphic Image

7 Resize the sun if needed by clicking on a corner box. While holding the mouse button down, 
push in or pull out to resize the sun.

Figure 87

Weld the Title and the Image

1 Move the summer sun image so that it overlaps the Summer title.

TIP: To move the image, hover over the Select Elements tool over the image until it changes 
into the Move tool. Click and hold the left mouse button as you drag it into place.

NOTE: If you leave parts behind, first click UNDO  to void your last action. Then drag a 
box around the sun to grab all the par

2 Select the outsides only of the sun and the title Summer. To do so, click the outline of the 
sun with the Select Elements tool. Then, while holding down the SHIFT key on your keyboard, 
click on the outside the of the title Summer. 
TIP: ts.

3 Boxes should then surround Summer and the sun, as shown in figure 88.
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Figure 88

4 Click Tools and then click Welding to weld the title Summer and the sun together, as 
shown in figure 89.

Figure 89

Congratulations! You have just created a title with an image attached!

Create a Shadow Mat for the Title (Optional)

Step 1: Create the Shadow 

1 Select the entire title by dragging a 
box around it with the Select Elements tool.

Resize the title to your liking by clicking on one of 
the corner boxes. Hold the mouse button as you pull 
out to enlarge or push in to make smaller.

Figure 90

2 Click on the screen away from the title. This will 
de-select the title and the boxes will disappear.

3 Select the outside of the title only by using the Select Elements tool  to click on an 
outside line. This will allow you to create a shadow only for the outline.

TIP: For this project you will not create inside parts for the shadow. In future projects, if you 
would like to have the inside parts cut out on the shadow, select the entire title.
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4 Go to the Tools menu at the top at the screen and then click Outline.

Figure 91

5 Make the following selections in the Transformation box (see figure 92).

Figure 92

6 Click the yellow check mark to accept the outline.

 For This setting  Enter This Value  Notes

Thickness 0.08 In most cases, widths are 
between 0.02 and 0.10.

Number 1 The Number setting specified 
the number of outlines. Three 
is the maximum possible.

Outline Click the box to select it. 
Then, choose the color of the 
outline by clicking on the 
rainbow color cube.

Be sure to select only the 
outside line of the sun and 
the word summer.

Break Text Click the box to select it. Check this box so that you 
will be able to separate the 
title (text) from the outline.
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TIP: If you need to undo something click the Undo tool at the top of screen. 

The Outline now appears in a different color around the title.

Figure 93

Step 2: Separate and Position the Shadow

1 Zoom the project in to make it easier to see by clicking on the Zoom Selected tool.

Figure 94

2 Click away from the title to de-select it.

3 Select the red outline by clicking on it with the Select Elements tool. 

4 Move the mouse until you see the arrow change to a double cross that indicates Move.

5 Click mouse button and drag the outline away from the title.

Figure 95

6 Position the title where you want it on the page:

Drag a box around the entire title using the Select Elements tool.  Then move arrow over 
title until you see a double cross. Click and hold mouse button down as you move the title into 
place.

TIP: Remember that you need to drag a box around the entire title to “grab” all the inside and 
outside parts.
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7 Position the shadow below the title.

8 Cut your project. For instructions, see “Cut the Project” on page 41.

TIP: Cut the title and shadow twice using two different colors of paper. Then you will have 
two titles with mats.
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Tutorial 3: Prepare, Scan, and Convert a Basic Line 
Graph to Cutting Format

In this tutorial, you will learn how to convert a basic line drawing into cutting format to create 
a cutting image. The line drawing can be your own creation or one found in a coloring book, 
workbook, or other resource.

NOTE: Tutorial 3 and Tutorial 4 introduce advanced skills. Be sure you are comfortable with 
the skills introduced in Tutorial 1 and Tutorial 2 before attempting the advanced tutorials. You 
can complete advanced tutorials in any order.

Prepare the Line Graphic
The most easily converted graphics are simple drawings with few intersecting lines.

1 Enlarge the drawings if necessary. The drawing should be at least 3"x 3". Bigger is better! 
See figure 96.

Figure 96

2 Use white out to erase parts of lines that are not wanted. Look in particular at any 
intersecting lines. Draw additional lines if desired See figure 97.

Figure 97

TIP: In some cases, it might be better to trace the drawing. Always trace if the original 
drawing has rough lines.Use the fine-point permanent marker such as a Zig pen.



Chapter 4 Creative Cutter Tutorials

Creative Cutter PRO 63

Scan the Drawing into Pazzles Creative Cutter

1 Open the Pazzles Creative Cutter program.

1 Double-click the icon your desktop screen. See figure 98.

Figure 98

2 Press the ESC key on your computer keyboard when you see the Welcome screen.

3 In the next window, click the Create New Document image at the left of the screen. See 
figure 99.

Figure 99

4 In the Setup page box, type 12 in both the Length and Height boxes.These settings set up 
the cutter to cut a 12x12 paper and reflect the actual available cutting space on the paper.

TIP: Be sure you have the toolbars used most often selected. Click View and then click 
Toolbars. Then click Standard, Tools, Manipulation, and Zoom.

5 The very first time you scan, you must select the scanner. Make sure you have connected 
your scanner to the computer and that the scanner is powered on. Click File and then click 



Chapter 4 Creative Cutter Tutorials

64 Creative Cutter PRO

Select Source. You might need to power on the scanner and then close and then re-open your 
computer. Be sure to turn the scanner on before turning on the computer.

Figure 100

6 In the Select Source box, highlight your scanner and click Select. If you have more than 
one scanner, be sure to select the correct one! See figure 100.

7 To scan, click File and then click Acquire to open your scanner software.

Figure 101
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8 Scan the drawing as black and white bitmap. See figure 102.

TIP: Your scanner software might look different from the pictures.

Figure 102

9 Set the resolution (DPI) to at least 250.

10 Scan the image.
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Convert the Scan Into Cutting Format: Vectorization
Your scanned image should be visible on the Pazzles Creative Cutter workspace, as shown in 
figure 103. 

Figure 103

1 Verify that the image is selected. If it is, it will be surrounded by small boxes. If it is not 
selected, click the Select Elements tool and select it.

The image must be converted from pixel format (dots) to vector format (lines). This process is 
called vectorizing. Think of it as connecting the dots.

TIP: The smoother your lines are to begin with and the closer your dots are together, 
(resolution), the better the cutting image. Be sure to scan at 250-300 dpi.

Most computer graphic programs create objects with tiny dots called pixels. The number of 
pixels per inch, which is also referred to as dots per inch (dpi) is called the object’s resolution. 
The higher the resolution, the more dots per inch. And, the higher the resolution, the more 
detail in the graphic. 

To see the difference between an image created at 72 dpi and 300 dpi, look at figure 104. As 
you can see, the closer the dots are to each other (and therefore, the higher the resolution), the 
smoother the cutting lines and curves. For more information on working with graphics, 
see“Working With Graphics” on page 109. 

Figure 104

300 dpi

72 dpi
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2 On the menu bar at the top of the screen, click Bitmap.

Figure 105

3 On the menu that opens, click Vectorization, and then click Automatic Vectorization. See 
figure 105. The Vectorizing tool, which looks like a magic wand, becomes available.

4 Using the Vectorizing wand, click on the image. See figure 106.

• If the Working... box appears, you have successfully vectorized the image, and you can go on to 
“Edit the Image” on page 69. The Working... box provides a running tally of the percentage of 
vectorization that is complete. See figure 106..

• If the Working... box does not appear, change the resolution (see “Changing the Resolution: What 
to Do If You Get a Message About Converting the Image to Black and White” on page 68).

Figure 106
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Changing the Resolution: What to Do If You Get a Message About 
Converting the Image to Black and White
If you get a message stating that you must convert the image to black and white, it means that 
you did not scan in black and white bitmap. Click OK and complete the following steps.

1 Click the Bitmap menu and then click Change Resolution. The Change Resolution tool, 
which looks like a cog wheel, becomes available.

2 Using the Change Resolution tool, click on the image. When you do, the Bitmap 
resolution window opens to display information about the image. See figure 107.

Figure 107

3 Working step-by-step, bring the settings down to 1 (bits per pixel) and None (Dithering 
method). Here’s how to do it with the example shown in figure 108. 

Figure 108

1 Click 4 and None and then click OK. 

2 Click the image again with the vectorizing tool.

3 Click 1 and None and then click OK.

4 Repeat the procedure “Convert the Scan Into Cutting Format: Vectorization” on page 66.
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Edit the Image

1 Delete the original bitmap. To do so, click the Select Elements tool, click on the original 
drawing, and then press the DELETE key on your keyboard. The scanned image remains on your 
screen. See figure 109.

2 Delete the box that is outside the image. Click on the box line with the Select Elements tool 
and then press DELETE on your keyboard. 

Figure 109

3 Delete unwanted lines. Select a line by clicking on it with the Select Elements tool and then 
press DELETE. See figure 110. The image on the left shows unwanted lines in red. The image on 
the right shows the image after the unwanted lines are deleted.

TIP: You can identify a line that is selected for editing because it is surrounded by black 
boxes.

Figure 110

4 Move the image to the upper-right portion of the workspace. 

To move the image, first select both the inside and outside of the image by clicking a spot 
above and to the left of the image. Then, hold down the mouse button as you drag the mouse 
to the right and down to create a box around the entire image. (Draw a big box to ensure you 
catch all parts of the image.)

When you release the mouse button, small boxes that indicate the image is selected should 
appear, as shown in figure 111.
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Figure 111

With the image selected, move the mouse over the image until the arrow turns into a cross 
symbol (the Move symbol). Click and hold down the mouse button as you drag the image into 
place on the page. Place it about one inch down and one inch in from the left side of the page, as 
shown in figure 112. 

Figure 112

5 Use the Move Point tool to fix small bumps and flaws like the one shown in figure 113.

Figure 113
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• Select the tool and click on the bump to grab the line. 

• Hold the mouse button down and push in or pull out to fix the flaw, as shown in figure 114.

Figure 114

TIP: Cutting images are made of lines (segments) and points. Points are where two lines meet. 
If you push or pull in the middle of a line you create an arc.  If you push or pull at a point 
you create an angle.

6 Fix bumpy, rough lines, like the one shown in figure 115 with the Line Smoothing 
(Replace Segment) tool. Click the tool above the bumpy area. Then, while holding down the 
mouse button, drag along the line to a spot below the bumps. Release the mouse button to 
replace the bumpy line with a smooth one, as shown in figure 116.

Figure 115

Figure 116

Pull out Push in
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Multiply the Image, Fill the Page, and Cut the project

1 Use the procedure “Multiply the Image and Fill the Page” on page 37 to create multiple 
copies of the image and fill the page.

2 Place a 12x12 paper on the cutting mat.

3 Insert the 12x12 paper on mat into the Creative Cutter.

4 Starting with step 2, follow the procedure “Cut the Project” on page 41 to cut the project.

Congratulations! You’ve completed the tutorial!
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Tutorial #4: Hand Vectorizing a Graphic or Photo
You can convert any drawing, graphic, or photograph to a cutting file by hand vectorization. In 
simple terms, hand vectorizing involves using some basic drawing tools to trace around the 
image. You might find that this becomes your preferred method of converting graphics!

NOTE: Tutorial 3 and Tutorial 4 introduce advanced skills. Be sure you are comfortable with 
the skills introduced in Tutorial 1 and Tutorial 2 before attempting the advanced tutorials. You 
can complete advanced tutorials in any order.

1 Open Pazzles Creative Cutter and create a blank 12x12 page. 

2 If you are importing an image, use the instructions that follow. If you are scanning an 
image, go to “Trace the Graphic (Hand Vectorize)” on page 75. Be sure to verify your scanner 
is selected, connected to the computer, and powered on. For a review, see “Scan the Drawing 
into Pazzles Creative Cutter” on page 63. 

Import an Image Saved on Your Computer

1 Click File from the Pazzles Creative Cutter menu bar.

Figure 117

2 Click Import and then click Image. See figure 117.

3 In the File Import box, find the location of our saved graphic or picture. To view small 
pictures of your image files, click the View tool and choose Thumbnails. See figure 118.

Figure 118
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4 Scan the drawing as a Color Picture or Photo, at a resolution of at least 250. When you do, 
the image appears on the Pazzles Creative Cutter workspace, as shown in figure 119.

Figure 119

Resize the image to fill the screen. To do so, first click the image with the Select Elements 
tool. Click a corner handle and hold down the mouse button while you drag the picture to a 
larger size. See figure 120. 

Figure 120
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Trace the Graphic (Hand Vectorize)

Step 1: Review the Location and Uses of Tools

The tools described in the following table are those that are most-often used during hand 
vectorizing.

Step 2: Set the Line Thickness and Color

1 Double click on the Segment from Path tool to open the Segment toolbar. See figure 121.

2 Click the Segment from Path tool.

3 Click the Pen and Brush tool to open its window. See figure 121.

4 Change the Pen width to 0.04 thickness and click Apply.

 Tool  Toolbar icon  Notes

Segment from Path As you draw a segment with this tool, it will 
automatically join the segment previously 
created. To start drawing, click and drag a line. 
To continue drawing lines, click on a spot 
further away and the line will follow.

Segment toolbar Double click the Segment from Path icon to 
bring up the Segment toolbar. Use the first two 
buttons to trace around the image.

Segment tool Draws independent segments. Used most often 
for accent lines.

Move Point tool Shapes the lines to fit the picture.

Join Two Points 
tool

Joins the ends of two lines. To use, drag a small 
box around the ends.

Magnify tool Zooms in on an image so you can see detail 
better.

Show Open Paths 
tool

Locates the adjoining ends of segments that 
have not yet been connected.
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Figure 121

5 Click the Color Palette tool to open the Color window. See figure 122.

6 Right-click your mouse button on a color for the tracing line. Choose a color that will stand 
out from the picture, such as red or bright pink. 

Figure 122
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Step 3: Begin Tracing the Picture

1 Click the Magnify tool and use it to enlarge a section of the picture.

2 Click the Segment from Path tool. 

3 Click on a starting point and hold the mouse button down as you drag the starting line. See 
figure 123.

Figure 123

4 Continue tracing around the picture by clicking on a spot some distance away from your 
first line. As you click along the outline of the picture, a line fills in between the points. See 
figure 124.

Figure 124
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Step 4: Continue tracing and refine

1 Create smaller segments around tight areas, 
as shown in figure 125.

2 Click the Redraw tool to turn the line color to red (or whatever color you have 
chosen). 

Figure 125

3 Continue tracing around the picture until you reach the starting point. The ending and 
beginning points should connect automatically. See figure 126.

Figure 126
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4 Click the Magnify tool to enlarge a section of the picture if necessary.

5 Click the Move Point tool. You will use it to shape the lines to fit the picture See 
figure 127. 

Figure 127

6 Click on a segment that must be rounded and hold down the mouse button as you move the 
line in or out.

• To round the segment, click the middle of the segment.

• To resize the segment or create a point, click an end point of the segment.

7 Continue shaping the lines as needed all around the outline.
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Step 5: Outline Other Features 

1 Continue to use the Segment from Path tool to outline other features. Keep in mind that 
when using the Segment from Path tool, the end of the line must connect with the beginning 
point. 

Figure 128

2 Use the Draw Segment tool to add individual accent lines. These accent lines do not 
connect to the lines you made previously. See figure 129.

TIP: Remember to use the Redraw tool to turn the lines red, if necessary.

Figure 129
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3 Use the Move Point tool to shape the accent lines. 

• To round the segment, click the middle of the segment.

• To resize the segment or create a point, click an end point of the segment.

4 Use the Join Two Points tool to connect the ends of lines. Click and hold down the mouse 
button while dragging around the end points that need to be joined. When you release the mouse 
button, the ends should join together. See figure 130.

Figure 130
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Step 6: Check your Work

1 Using the Select Elements tool, click on the image and hold down the mouse button as you 
drag a box around the new outline. When you release the mouse button, all lines within the box 
are selected.

2 From the Edit menu, click Copy and Paste to make a copy of your project. The copy will 
assist you in seeing if any adjustments must be made. See figure 131.

Figure 131

3 Make changes and adjustments as desired. 

4 Click on the graphic (photo) portion of the screen to select the photo.

IMPORTANT: Do not drag a box around everything and do not use Select All. If you do, you 
will delete the entire project.

5 Press the DELETE key on your keyboard to remove the photo. When you do, only the newly 
created cutting image remains on the screen.
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6 Click the Show Open Paths tool to find any end points that need to be connected. The 
program zooms in on all loose ends. 

• Ignore the open ends you wish to leave open.

• Fix the ends you wish to close. To do so, use the Join Two Points tool to drag a small box around 
the points to connect the ends.

Figure 132

7 Your project is done. See figure 132. Be sure to name and save it.

Congratulations! You completed the tutorial!
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5 M a n i p u l a t i n g  L e t t e r s  a n d  
S h a p e s

This chapter provides the information you need to add special effects to a variety of fonts and 
images. 

Tools Used for Manipulating Letters and Shapes

Tool Toolbar icon Use to...

Text tool Write text. Click the icon, click on the screen 
where you want to start typing, and then type the 
text.

Font tool Select a font and font size to apply to text. Pazzles 
Creative Cutter comes with cutting fonts, which 
are optimized for use with the Creative Cutter. 
You can also use TrueType fonts that are stored in 
your computer’s Windows Fonts folder.

Select Elements Select letters, words, objects, and parts of objects. 
To move, resize, or manipulate an object or word, 
you must first select it. 

Select the text on a page for previewing how it 
will look in other fonts. Click the text with the 
Select Elements tool, click the Text menu, and 
then click Font to open the Font preview 
window.

Erase tool Erase all or part of an image. Click on the part of 
the image you want to erase or drag a square 
around it. If you want to erase a letter or parts of a 
letter, convert the text to a path first. 
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Undo Reverse the last action completed.

Redo Reverse an undo. 

Zoom Enlarge parts of the page so you can see them 
better. Click and drag around the image while 
holding down the mouse button.

Zoom toolbar Enlarge or reduce the size of a selected object to 
help while editing it.

Change Color 
tools 

Open the color palette to change the color of an 
outline or fill. Right-click on a color to change line 
color; left-click to fill with color.

Mirror/Rotate Mirror: flip an object vertically or horizontally. 
Rotate: turn the selected element by the number of 
degrees you specify.

Move point Select a construction point on an element and then 
move it in, out, up, or down. Move Point is 
helpful in smoothing out imperfections in 
drawings. Click the center of a segment and move 
in or out to create an arc.

Break and Move Place a break in the image line and then bend or 
manipulate the line.

Cut Straight Line Cut a straight line across an object to separate it 
into two separate parts.

Join two points Join the ends of two lines together.

Cut Path Cut a line into two sections.

Tool Toolbar icon Use to...
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Changing the Look of Images and Text
You can change the look of text and images in many different ways. The easiest is to change the 
font in which the text appears. More complex techniques include adding shadows, distorting 
text, and creating curved words and titles.

Changing and Previewing Various Fonts

1 Using the Select Elements tool , click the text you want to change to select it. 

2 Click the Text menu and then click Font. When you do, the Font box opens with a preview 
of the selected text in the current font.

3 Click the type of font you wish to use, either True Type or Cutting. (Cutting is 
recommended), and then click a font from the displayed list of available fonts. The Preview 
boxes show the text with the new font applied.

4 When you are satisfied with your font selection, click OK to close the Font box and apply 
the new font to your text.

Measure Tools menu Measure the size of the project. From the Tools 
menu, click Measure. Then, click the project start 
point, hold down the mouse button, and drag the 
measuring line to the end point. 

Drawing tools Draw shapes. To view the drawing tools, click the 
rectangle.

Justify Position objects correctly. You can justify the 
position of objects centered to each other, on the 
page, or to the left, center, or right. Click the 
Justify tool to open the Justification toolbar, and 
then click the type of justification you wish to 
apply.

Justification 
toolbar

Tool Toolbar icon Use to...
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Moving and Resizing Images 

Use the Select Elements tool to manipulate a single element or multiple elements.

Selecting an Object

With the Select Elements tool selected, click the item(s) you want to resize, move. or change. 
See figure 133.

• To work with a single element, click the element. 

• To work with a group of elements, drag a box around a group. See figure 133.

• To select both the inside and outside of an object, drag a box around the entire object.

Figure 133
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Resizing an Object

1 Select the image with the Select Elements tool. When you do, small black boxes appear 
around the image. See figure 134.

Figure 134

2 Click one of the small black boxes to resize the image. While holding down the mouse 
button, click one of the black boxes and push it in or out. 

Moving an Object

1 With an object displayed on your screen, use the Select Elements tool to select it. (If you 
prefer, you can use Select All from the Tools menu.

2 Click directly on the center of the object and hold down the mouse button. When you do, 
the pointer changes to a cross (the Move tool).

3 While continuing to hold down the mouse button, move the object on your page.

TIP: Another method of moving objects is to click the center of the object, release the mouse 
button, and use the arrow keys on your keyboard.

Filling a Page With an Image (Multiplying) 

You can easily fill a page with multiple copies of the same image. 

1 Click the Select Elements tool and use it to drag a box around the image.

2 Right-click on the workspace and click Multiply on the menu that opens. When you do, the 
Multiply Selected Elements box opens. See figure 135.

3 Type in the number of rows you think will be needed to fill the page.



Chapter 5 Manipulating Letters and Shapes

90 Creative Cutter PRO

4 In the Copy direction box, click the arrow for the direction you want to place the objects.

Figure 135

5 Click OK. The page fills with the image, as shown in figure 136.

Figure 136

TIP: If you have too many or not enough images, click the Undo tool  and start over.

NOTE: You can also resize the entire group of images to fit the page. Click Select All and 
move the corner box in or out to resize.
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Measuring the Size of a Project

1 From the Tools menu, click Measure. See figure 137.

2 Click the project’s starting point

3 While holding down the mouse button, drag the measuring line to the end point. The 
distance is displayed at the bottom of the screen.

Figure 137

Creating Outlines and Shadows

Figure 138

You can create an outline shadow of any letter, number, word, or shape. Use the instructions 
that follow.

1 Write a word or open an image. 

2 Select the word or image.

• To outline both outside and inside parts, select the whole image by dragging a box around it.

• To create a shadow of only the outside, click on the outside line. (For text, first convert the text 
to a path.)
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3 From the Tools menu, click Outline. When you do, the Transformation box opens.

4 In the Thickness box, type a thickness (between 0.02 and 0.15) for the outline. 

5 In the Number box, type the number of outlines you wish to apply. Do not exceed three 
outlines.

6 Click the Outline box to check it. 

7 Click the color cube to choose a color for the outline.

8 Click the Break text box to check it. This allows you to separate the text from its outline.

9 Click the yellow check mark at the lower-right of the Transformation box to save and 
apply your outline selections. To separate the outline, see “Separating the Outline From the 
Word or Image” on page 92.

Outlining problems and solutions

If the program aborts while you are creating an outline or shadow, any of the following issues 
might be causing the problem.

• The image or word has too many outlines. Do not exceed three outlines.

• You attempted to outline a circle. Circles cannot be outlined. Use the Break and Move tool to 
create a point on a circle.

• The image or word has open paths that need to be closed. Select your object, use the show open 
path tool. This will show a circle around the open paths. Use the Join Two Points tool to close the 
open paths by dragging a box around the two paths that need to be joined. The area highlighted by the 
circle. Once your open paths have been closed try outlining again.

• Your outline choice is too large for the image size.

Separating the Outline From the Word or Image

1 With an outlined word or image displayed on your screen, right-click on the image.

2 On the displayed menu, click Color Selection. 

3 Click any line in the color of the outline. When you do, all lines of that color are selected, 
and you can move them to another location on the page.
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Distorting Words Into Different Shapes

The Distortion tool lets you change text or objects into crazy shapes!

Figure 139

1 Write a word or open an image, and then use the Select Elements tool to select it.

2 On the Tools menu, click Distortion. When you do, the Distortion box opens.

3 Select the type of distortion:

• Select Freehand to move the image yourself. Use the arrow tool to move points or lines.You 
can select 4 or 8 points (see step 5).

• Select Use Form to choose a pre-designed image distortion available in the top window. 
Scroll up and down to see the many shapes available.

4 Select a Work option:

• Keep lines is best used for shapes composed of only straight lines. Straight lines cannot be 
manipulated.

• Convert line to curve is used to add distortion to straight lines is possible. Use Convert line to 
curve if the drawing has curves.

5 Select the number of points you wish to move, either 4 or 8.

6 Click Apply to apply your selections to the text or object.

TIP: Try the distortion tool with the images too!
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Creating Curved Titles and Words 

Use the Fit Text to Path option on the Text menu to create text that curves under or over an 
arc.

Figure 140

1 Write a word. 

2 From the Draw menu, click Arc, Oval, or Circle. 

3 Draw the shape you want.

• To draw an arc, click Arc and then click (do not drag) at two different spots on the page. An 
arc appears between the areas where you clicked. If the arc is upside down, use the Select 
Elements tool to flip it over. Then, use the Select Elements tool to adjust the size and depth of the 
curve. 

• Be sure the arc is bigger than the word.

4 Using the Select Elements tool, drag a square around both the word and the arc. (If you 
prefer, use Select All under the Tools menu.)

5 From the Text menu, click Fit Text to Path. 

6 In the Write Text on...box, select the location on the arc where you want to write the text: 
top, bottom, left, or right. See figure 141 and figure 142.

Figure 141 Example of text curved to the top
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Figure 142 Example of text curved to right

7 Click Apply to save your selections.

TIP: To separate the line from the word, click Break text on the Write Text on... box. This 
allows you to delete the line so the word stands alone.
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Spelling Words Vertically 

This section provides two techniques for writing a word with its letters stacked vertically above 
the each other.

Using the Center Technique to Spell Words Vertically

Figure 143

1 Type the word letter-by-letter in the font you prefer. Press the ENTER key after typing each 
letter to move the cursor down to the next line. 

2 Use the Select Elements tool to select the word.

3 From the Text menu, click Center. When you do, the letters in the word line up underneath 
each other.
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Using the Break Text Technique to Spell Words Vertically

This technique is preferable when you have mixed upper- and lower-case letters. These letters 
often are not spaced evenly when typed vertically.

Figure 144

1 Type the word letter-by-letter in the font you prefer. Press the ENTER key after typing each 
letter to move the cursor down to the next line. 

2 Use the Select Elements tool  to select the word.

3 From the Text menu, click Break Text/Break by Character. This separates the word into 
individual letters. See column 1 in figure 144.

4 Use the Draw Rectangle tool to create a small box in the size you want to apply as spacing 
between the letters.

5 Position the rectangle between the first two letters. Select the letter to be moved and use the 
arrow keys on your computer’s keyboard to move the letter up or down. See column 2.

6 Continue using the rectangle as a spacer to help with the positioning of the letters. See 
column 3.

7 Use the Select Elements tool to select the entire word, and then drag a box around it. When 
you release the mouse button, all of the letters will be selected together.

8 From the Text menu, click Center. The letters in the word line up underneath each other. 
See column 4.

Joining Letters Together

This section provides two methods for joining letters: by using the Visual Text Spacing tool 
with Welding and by using the Welding tool to weld a bar to the bottom of a word.

Using Visual Text Spacing to Join Letters

1 Type a word in the font of your choice and then select it. 

2 On the Text menu, click Visual Text Spacing. Visual Text Spacing places a little box 
under each letter and an arrow pointing to the right under the word. See figure 145.

1 2 3
4
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3 Move letters to overlap, using the arrow tool or the little boxes. 

TIP: If you must lengthen parts of the letters to get the proper spacing, see “How to Lengthen 
Letters” on page 99.

Figure 145

4 Use the Select Elements tool to select the word. 

5 On the Tools menu, click Welding. When you do, the letters should join. If the letters do 
not join, click Undo, move them slightly, and try again. 
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TIP: You can fix distortions after welding by using the Move Point tool. See “Tips for Fixing 
Welding Problems” on page 101.

Figure 146

How to Lengthen Letters

• If you need to lengthen letters to obtain proper overlap, use the Move Point tool to lengthen them. 
For best results, weld first and then lengthen the letters. After lengthening the letters, weld the newly 
overlapped letters. 

• Create small rectangles to create a bridge between letters and weld together.

• If the letters have inside parts (such as an e or a B), be careful to select only the outside of the letter 
while welding. Click on the outside line of a letter, hold down the SHIFT key, and then click on the 
outside line of the second letter. Then, continue to weld.
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Using the Welding Tool to Join Letters With a Bar

Figure 147

1 Type a word in the font of your choice.

2 From the Draw menu, click Rectangle to draw a rectangle bar. 

3 Use the Select Elements tool to move the bar so that it overlaps word.

4 Use the Select Elements tool to select the bar and letters together. To do so, click Select 
All under the Tools menu or use the Select Elements tool to drag a box around all the elements. 

5 On the Tools menu, click Welding. 

6 Smooth out rough lines. by using the Move Point tool or by using the Replace By Segment 
tool.

TIP: If some letters distort during welding, break text by character and try to weld those letters 
last.
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Welding Images and Words Together

Use the following procedure to weld an image and word together, as shown in figure 148.

1 Move the word and images together so that they overlap. 

2 Select both objects by dragging a box around both of them.

3 On the Tools menu, click Welding.

Figure 148

Tips for Fixing Welding Problems

• If parts of words or objects disappear, select only the outlines of each object. To select the outline, 
click on the first object while holding down the SHIFT key, and then click on the next object.

• If objects do not weld, make sure the objects are overlapping and check for open paths. 

Using Drawing Tools to Change Letters and Images
You can modify the appearance of letters and images by using Pazzles Creative Cutter drawing 
tools. Use the tips that follow.

Tips for Using Drawing Tools

• When manipulating images, click and hold down the mouse button.

• To see the image more clearly, use the Zoom tool to enlarge it.

• If cutting or erasing a particular area is difficult, move that part of the image to the front. To do so, 
go to the Shape menu and click Order.
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Move Point Tool

The Move Point tool allows you to select a construction point on an element and then to move 
it in, out, up, or down. This is very helpful when smoothing out any imperfections in your 
drawing.

Figure 149

• Using the Move Point tool, click on a point in the object and then drag it.

• Click and drag the middle of a segment to create an arc. See figure 149.

• To display all joints and points, use the Move Point tool to drag a box around the object. Viewing 
all joints and points is very helpful when making precise adjustments. See figure 150.

Figure 150

Fixing Scanned Images With the Move Point Tool

Images that are scanned in often contain imperfections such as stray bumps. To fix this kind of 
flaw, click on the flaw with the Move Point tool and push or pull it into place.

Click on point with 
Move Point tool and 
drag to change point.

Click and drag on middle of 
a segment with Move Point 
tool to create an arc.
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Break and Move Tool

Use the Break and Move tool to place a break in the image line and then bend or manipulate 
the line. To use it, place a point at a new location and then move the point to create a new look. 
See figure 151.

Figure 151

Cut Path Tool

The Cut Path tool enables cutting out a segment of a line in an image. To use it, click two 
places with the Cut Path tool and then use the Erase tool to remove the cut section. See 
figure 152.

Figure 152

Alternatively, cut one spot and use the Move Point tool to move the ends to the location you 
prefer. See figure 153.

Figure 153

Create Tabs to Hold a Project On the Paper

1 Use the Cut Path tool to snip two breaks in the cutting line.

2 With the Erase tool, remove the snipped segment.
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Join Two Points Tool

The Join Two Points tool is helpful for joining the ends of two lines. To use it, select the Join 
Two Points tool and then click and drag a box around the two ends that are to be joined. 

Release the mouse button to join the points.

Figure 154

Change Color Line Tool

There are several reasons to change the colors of lines and fills:

• Changing colors allows you to choose cut order by color.

• Changing colors can make lines more visible.

• Changing the color of lines facilitates cutting different parts of the image at different pressures.

• Changing the color of lines helps to indicate the tools used for various lines, 

• Changing the fill color in an image helps you to visualize how the image will look when cut, and it 
facilitates printing the image on your color printer directly from Pazzles Creative Cutter. (Changing 
the fill color does not affect the way an image cuts.)

Use the following procedure to change colors in an image or letter:

1 Select the image with the Select Elements tool. 

2 Click the Change Color icon to open the Color box. See figure 155.

Figure 155
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3 Click the mouse on a color square.

• To change the line color, click the right button on your mouse.

• To change the fill color, click the left button on your mouse.

• To lighten or darken a color, move the color bars up and down.

4 To remove fill color, click the X under the B box on the Color box.

TIP:

• The B column applies fill color with a brush. 

• The P column applies outline color with a pen. 

Creating Words Inside a Rectangle 
You can manipulate the letters in words that are enclosed in a rectangle so that they are either 
separated or attached. 

Creating a Word with Separated Letters

1 Type a word.

2 From the Draw menu, click Rectangle.

3 Draw a rectangle under the word.

4 Weld the word and the rectangle together. See “Welding Images and Words Together” on 
page 101.

5 Use the Move Point tool to drag the bottom-left corner of the bar over the top of the word.

6 Use the Move Point tool to drag the bottom-right corner over the top of the word. The word 
will cut from the cardstock, as shown in the final image in figure 156.
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Figure 156

Creating a Word With Attached Letters

1 Type a word.

2 From the Draw menu, click Rectangle.

3 Draw a rectangle under the word.

4 Duplicate the rectangle (use ALT + D) and use the arrow key to move the new rectangle 
straight above the word. See figure 157.

5 Select both rectangles and the word and weld them together. See “Welding Images and 
Words Together” on page 101.

6 Use the Eraser tool to erase unnecessary parts of the rectangles. 

7 Join the ends of the bottom and top to create sides.

8 Draw a rectangle around the completed word. 
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Figure 157
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6 W o r k i n g  W i t h  G r a p h i c s

Achieving the pages you’re dreaming of sometimes means creating, scanning, or importing 
graphics. This chapter provides background information on computer graphics and tips and 
techniques for creating graphics that cut and display well. We recommend that you complete 
the practice project to gain experience with converting graphics (see “Practice Project: 
Converting and Vectorizing a Bitmap File” on page 114).

Introduction: Pixels, Resolution, Vectors, Oh My!
Most computer graphic programs create objects with tiny dots called pixels. The number of 
pixels per inch, which is also referred to as dots per inch (dpi) is called the object’s resolution. 
The higher the resolution, the more dots per inch. And, the higher the resolution, the more 
detail in the graphic. To see the difference between an image created at 72 dpi and 300 dpi, see 
figure 158.

Figure 158

Cutting the hundreds of dots that compose an image would be cumbersome and time-
consuming. Therefore, you must convert the image from pixels to vectors, which are lines and 
curves. This process can be done with the Pazzles Creative Cutter software, which essentially 
connects the dots for you. The closer the dots are to each other (and therefore, the higher the 
resolution), the smoother the cutting lines and curves. 

300 dpi

72 dpi
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Manipulating, Scanning, and Importing Graphics 

Scanning a Picture or Drawing into Pazzles Creative Cutter

1 Draw your design, preferably in black ink that is not too fine. It is helpful to draw it large; 
you can scale it down later on.

2 Place the image on the scanner bed. It is best if you scan one image at a time. If you want 
multiples of your drawing you can create copies within the program.   

3 From the Pazzles Creative Cutter File menu, click Select Source. Your scanner model 
should appear in the pop up window. (If not, make sure your scanner is hooked up to the 
computer and turned on.) You may need to restart your computer with the scanner turned on.

4 Choose your scanner and click Select. 

5 To scan, click Acquire. Be sure that the scanner properties are set to scan your project as a 
Black and White bitmap at a resolution of 250 dpi or higher. 

6 Activate the scan. Your project should appear in Pazzles Creative Cutter. When it does, use 
the procedure “Importing and Vectorizing a Word or Graphic” on page 110 to vectorize it.

Importing an Image or Word Created in CorelDraw or Adobe 
Illustrator

If you have created the design in Adobe Illustrator or CorelDraw, save it as an Adobe Illustrator 
6.0 (AI) file and import into the cutting program. Be sure to convert text to lines, using vector 
as the conversion mode. You will not need to vectorize the image in Pazzles Creative Cutter. 

NOTE: This type of file sometimes results in doubled-up or duplicate lines.

Converting and Vectorizing Graphics
The best graphics for vectorizing are solid (filled in) and saved in black and white bitmap (bmp) 
format at 250 dpi or higher). Refer to the sections that follow to automatically vectorize images.

Importing and Vectorizing a Word or Graphic

1 Save the image as a black and white bitmap (.bmp) file at a resolution of 250 or higher. 
Lower resolution will yield unsatisfactory results. See “Converting an Image to Black and 
White Before Saving as a Bitmap” on page 114.

2 Open a blank page in Pazzles Creative Cutter. 

3 From the File menu, click Import and then select Image.

4 In the File Import box, browse to the location where the file is saved, select it, and click 
OK.

5 With the image still on the screen, open the Pazzles Creative Cutter Bitmap menu.
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6 On the Bitmap menu, click Vectorization and Automatic Vectorization. See figure 159.

Figure 159

TIP: For detailed information on vectorizing, see “Tutorial 3: Prepare, Scan, and Convert a 
Basic Line Graph to Cutting Format” on page 62.

7 Click the image to start converting it to a vector image. Vectorizing can take a few minutes. 
When the image is converted, the new image appears in yellow next to the original.

8 Use the Select Elements tool to select the original black and white image, and then delete 
it.

9 Delete the outside square and any extra lines around the converted vector image. 

10 Use the Select Elements tool to drag a square around the converted vector image and then 
move it to the appropriate location on the page.

TIP: You might want to the change the line color to make the image more visible.

Tools and Tips for Cleaning Up Vectorized Images

Depending on the quality of the original image, you may have less than perfect lines after 
vectorizing. Use the tips that follow to fix problem areas.

Replace a Line

Use the Replace by a Segment tool  to replace the line. Click and drag a line over the 
problem area to replace it with a smooth line.

Replace a Rough Curved Area

Use the Replace by an Arc tool  to replace the rough curved area. Click at the start and at 
the end of the curve. (See figure 160.) You might need to use the Move Points tool to move the 
arc into place.
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Cut Away Points or Bad Areas

Use the Cut Straight Line tool  to cut away points or bad areas. Drag the tool the separate 
the unwanted area. See figure 161.

Figure 160

Figure 161

Smooth a Selected Area

Use the Simply Path option from the Shape menu to smooth a selected area. Click the area 
several times to remove extra points.

Convert an Uneven Circle 

Use the Convert to Circle tool (double click the Oval tool) to convert an uneven circle 
to a perfectly shaped circle.

Straighten a Crooked Line

Use the Horizontal/Vertical tool  to straighten a crooked line horizontally or vertically.

Eliminate Stray Lines

Use the Move Point and Eraser tools to eliminate stray lines. If stray lines appear in scanned 
drawings, they might be caused by stray dots in the scan, either from flaws in paper or dust on 
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the scanner. The program is trying to “connect the dots” for you. Use the Move Point tool to 
drag the end of the line outside of the image and then click the Erase tool to remove them. 

Remove Extra Lines

To remove the extra lines, select the lines and press the DELETE key on your keyboard. If the 
lines are difficult to remove, use the Erase tool to remove two or three pieces of the unwanted 
line and then select and delete the broken sections. 

Avoid Double Lines

Convert the image to a solid graphic to avoid those pesky double lines. To do so, color the 
image by hand (solidly!) or use a graphics program to fill in before vectorizing.

Fixing Vectorizing in Scanned Drawings or Photographs

If you encounter problems when trying to vectorize a scanned drawing or photograph (not an 
outline or solid), convert images to an outline or solid image. To do so, first outline it by hand 
with a black pen. Then, scan at 200 dpi in black and white, or use a “paint” or graphics program 
to fill the image in and make it solid. Save the image as a black and white bitmap (bmp) file, 
vectorize, and remove any double lines after vectorizing. Alternatively, use the hand-
vectorizing method described on page 114. 

Converting Low-Resolution Images

Some publishing programs (such as MS® Publisher, Printshop, and Printmaster) feature 
program-specific file formats. Images created in these programs often are low resolution, and 
you may not be able to save them in bitmap format. To remedy the issue, print the image in 
BEST quality, trace it, and then scan it in as a black and white bitmap. See “Manipulating, 
Scanning, and Importing Graphics” on page 110. Alternatively, use the hand-vectoring method 
on page 114.
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Converting an Image to Black and White Before Saving as a 
Bitmap 

If you receive a message during vectorizing that you are using the wrong file format or if 
nothing happens when you start to vectorize an image, the image was not saved in black and 
white bitmap (bmp) format. Use this procedure to fix the problem.

NOTE: This procedure will not work if your image is in Index format.

1 From the Bitmap menu, click Change Resolution. 

2 Click on the image. When you do, the Bitmap Resolution box opens. 

3 Working step by step, change the Bits Per Pixel and Dithering Method selections from the 
current settings down to 1 bit per pixel and Dithering Method to None. Do not go directly from 
the current setting to 1 bit per pixel and Dithering None; you must proceed through each 
option.

4 Proceed with vectorization. See “Importing and Vectorizing a Word or Graphic” on 
page 110.

Practice Project: Converting and Vectorizing a Bitmap File

1 From the File menu, click Import and then click Image. 

2 Locate and open Sample Bitmap 2 on the Creative Cutter CD. 

3 On the Pazzles Creative Cutter Bitmap menu, click Vectorization and Automatic 
Vectorization.

4 Click on your scanned image. When you do, the program begins to convert it to a vector 
image. This process can take a few minutes, especially if the image is detailed.

5 When the vectorizing process is complete, the new image appears in yellow next to the 
original. (To change the color, see “Step 1: Prepare the Image and the Tools” on page 115.) You 
can delete the box if you wish. 

6 Click the Select Elements tool, click on the black bitmap image, and click DELETE to 
remove it. 

7 To view the vectorized image more clearly, click the View Page tool and click on the 
screen. Then, use the Select Elements tool to drag a square around the image and move it onto 
the page, if necessary. Use the View Page tool to enlarge the page for better viewing.

Hand-Vectorizing An Image
You can convert any drawing, graphic, or photograph to a cutting file by hand vectorization. In 
simple terms, hand vectorizing involves using some basic drawing tools to trace around the 
image. You might find that this becomes your preferred method of converting graphics!
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For more detailed information and instructions, see “Tutorial #4: Hand Vectorizing a Graphic 
or Photo” on page 73.

Step 1: Prepare the Image and the Tools

1 Scan a photo or graphic into Pazzles Creative Cutter or open a graphic that is already saved 
on your computer. See figure 162.

Figure 162

2 Resize the graphic to fill the screen. Using the Select Elements tool, click one of the 
image’s corner handles. While holding down the mouse button, drag the picture to a larger size.

3 Double click the Segment tool (located on the left side of the workspace) to open the 
Segment toolbar. You will use the first two tools on the toolbar.

Figure 163

4 Set the line thickness by clicking the Pen and Brush tool to open the Pen window. Change 
the Pen width to 0.04 or 0.05 and click Apply.

5 Set the line color by clicking the Color Palette icon to open the Color window. Right click 
on the color of your choice.

Step 2: Trace the Image

1 Use the Magnify tool to enlarge a section of the picture.

2 Click the Segment from Path tool.



Chapter 6 Working With Graphics

116 Creative Cutter PRO

3 Click on a starting point and then hold the mouse button down as you drag the starting line. 
See figure 164.

Figure 164

4 Continue tracing the image by clicking on a spot some distance away from your first line. 
As you click along the outline of the image, a line will fill in between the point.

5 Click the Redraw tool. When you do, the line colors changes to red. See figure 166.

6 Continue tracing around the picture until you reach the starting point. The beginning and 
ending points should connect automatically.
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Step 3: Shape the Lines to Fit the Image

1 Click the Move Point tool and begin to shape the lines to fit the image. See figure 165.

Figure 165

• To round a line, click the middle of a segment.

• To resize a segment or to create a point, click on an end point of a segment.

2 Shape the lines all the way around the outline as needed.

3 Use the Segment from Path tool to outline other features. Keep in mind that when using 
the Segment from Path tool, the end of a line must connect with the beginning point. 
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4 Use the Draw Segment tool to add individual accent lines. Accent lines do not connect the 
the line made previously. See figure 166.

Figure 166

5 Use the Move Point tool to shape the accent lines.

6 Use the Join Two Points tool to connect the ends of lines. To do so, click and hold down 
the mouse button while dragging a box around the end points that need to be joined. When you 
release the mouse button, the ends should join.

7 Select the image (picture) portion of the screen and delete it. The newly created cutting 
image remains on the screen.

8 Fix any open paths. First, use the Show Open Paths tool to find unconnected end points.
Next, use the Join Two Points tool to drag a small box around the points to connect the ends. 
See figure 167.

Figure 167
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Tracking Customer Data
Use the Customer option on the Edit menu to keep records of your customers’names, prices 
charged, and fonts and images.

Figure 168
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7 S p e c i a l i z e d  C u t t i n g  a n d  
F i n i s h i n g  T e c h n i q u e s

This chapter provides tips and techniques for specialized cutting requirements, including 
cutting on unusually sized papers, cutting on media other than paper, and applying special 
effects such as embossing during cutting. 

Tips for Cutting Unusual Media and Sizes

WARNING! When you are working with unfamiliar or heavy materials, do not leave the cutter 
unattended. If the cutter gets stuck in your absence, the motor could burn up. This type of 
mishap is not a warranted repair.

Type of 
Material Notes

Vellum Be sure it is well adhered to the mat.

Mulberry paper Be sure it is well adhered to the mat. Try using mulberry cardstocks or 
sticky-back mulberry papers.

Cork Use the thinnest roll you can find. Run it through a Xyron machine 
first. Use simple designs. Extend the blade out to its full length.

Magnetic sheets Use simple designs. Extend the blade out to its full length. Cut two 
times.

Plastic sheets Cutter can cut many thicknesses; some might need to be cut two or 
three times. Be sure it is well adhered to the mat.

Transparency 
plastic

Be sure it is well adhered.

Thin metal foil Use an old blade and high pressure. Extend blade out slightly, use 100-
110 pressure.

Metallic papers Increase pressure. You may need to cut two or three times.
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Special Techniques for Cutting

Moving Objects From the Front or Back When Working With 
Lines

Objects are placed on the page in layers that can be rearranged for easier manipulation. Use the 
Move to Back/Move to Front tool to manipulate the image on your screen. See figure 169.

Figure 169

Sorting the Inline Path Fefore Cutting

Use this procedure to prevent a letter or object from popping out of the paper during cutting.

1 Use the Select Elements tool to select the object. Be sure that all parts of the object are 
selected.

2 On the Tools menu, click Sort inline path before outline.

Printable canvas Make sure it is well adhered to mat.

Paper-backed 
fiber/straw papers

Might require two cuts. Cut on slowest speed.

Stiff fabrics and 
adhesive-backed 
fabrics

Make sure it is well adhered to mat.

Type of 
Material Notes
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Troubleshooting Problems With Inline Cutting

If a program error appears and the program shuts down while completing this procedure:

• You might have circles and ovals in the project. Create extra points with the Break and Move 
tool.

• You might have open paths. Use the Show Open Paths tool to find them. Use the Join Two 
Points tool to close them.

Cutting a Project More Than Once

If your project uses heavy paper or other materials, you might need to cut two or three times. 
Do not lift the rollers after the first cut! 

To make cut multiple times, use one of the following methods:

Method 1: Press Copy on the cutter control panel. Be sure Advance is not checked in the 
Cutting Control Panel.

Method 2: Press Start.

IMPORTANT: It is essential that the Advance box is NOT checked and that you do NOT lift 
the pinch rollers!

Creating Stencil Cuts 

You can make any font into a stencil cut. See figure 170.

Figure 170

1 Type a word and select Convert Text to Path from the Text menu.

2 Click the Cut Straight Line tool and use it to cut away sections of letters.

3 Drag and draw two lines across the section you want to remove.

4 Remove unnecessary pieces by selecting the sections and deleting them. See figure 171.
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Figure 171

Scoring Paper 

If you want to score part of the project and cut another, as you would for an envelope, use the 
following guidelines:

• Complete the process in two separate steps. 

• Be sure to change the color of the scored part of the project. (See “Change Color Line Tool” on 
page 104.)

Scoring and Then Cutting an Image

IMPORTANT: Do not lift the pinch wheels between steps.

1 Select the color for scoring. 

2 Reduce the pressure setting to a light pressure. See figure 172.

3 Click Start. 

4 Select the color for cutting and increase the pressure.

5 Click Start.

Figure 172

TIP: You can also use the KissCut function to create scoring. See “Converting Lines to Stitch 
Marks” on page 126.
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Cutting Round Corners

1 Draw a rectangle on the page.

2 Click the Round Corner tool.

3 In the Radius box, assign a value to apply to the corner and then click OK. To change this 
value later, double-click on the computer screen. See figure 173.

Figure 173

TIP: If you choose too large a radius, or a tiny segment is near the corner, you will get an error 
message.

4 Click the Round Corner tool on the corner you want to round. See figure 174.

Figure 174



Chapter 7 Specialized Cutting and Finishing Techniques

126 Creative Cutter PRO

Cutting Around Tight Corners 

To get clean cuts with fonts that have tight corners and angles, use the tips that follow.

• Use the Break and Move tool create a new break in the line.

• Use the Move Point tool to move the point away from the break. Doing so creates curves instead 
of points. The curve is imperceptible to the eye but greatly eases cutting. See figure 175 and 
figure 176.

Figure 175

Figure 176

Creating Stitch Marks

You can convert lines to stitch marks. Two lengths of stitch marks are available: KissCut1 and 
KissCut2. 

Converting Lines to Stitch Marks

1 Click the Pencil tool on the left toolbar to open the Pen/Brush window. See figure 177.

2 In your image, select the line to convert.

• To apply kiss cuts to ovals and circles, use the Break and Move tool to create more points. 
Then, click on the line at four equally spaced spots.

• To apply kiss cuts to text, first apply Convert Text to Path from the Text menu to the text.
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3 In the Pen/Brush window, select KissCut1 or KissCut2 and then click Apply.

TIP: Remember to change back to a solid line before you type or draw. If you don’t, your lines 
will continue to be KissCut style.

Figure 177

Piercing With the Creative Cutter
Use the piercing tool to pierce metals, cardstock, and vellum. Piercing is a multi-step process.

Step 1: Insert the Piercing Tool and Set Equidistant Points

IMPORTANT: Do not overtighten the thumbscrew during insertion.

1 Insert the piercer into the cutter’s carriage, using the same opening as the blade holder. 

2 Verify that the tip is approximately 1/8" to 1/4" from the surface to be pierced.

3 Select the object you are going to pierce.

4 From the Shape menu, click Convert to Equidistant Points. See figure 178.
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5 Type the distance between points and then click OK. See figure 179.

Figure 178

Figure 179

Step 2: Use the Piercing Tool

1 Assign piercing lines a different color from rest of project lines.

2 Select the lines to be pierced and convert to equidistant points. See “Step 1: Insert the 
Piercing Tool and Set Equidistant Points” on page 127.

3 Place paper, metal, or vellum paper on the velvet plush piercing mat.

4 Insert the project on the mat into the Creative Cutter. 

5 Lower the pinch rollers and press F4 to measure.

6 Press F1 until you see Pen Mode. Do not omit this step!

7 Open Pazzles Creative Cutter and set the pressure to approximately 400.

8 Select the appropriate color box for points.

9 Click Start to begin piercing. If the tool drags lines, try decreasing the pressure.
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Step 3: Resume Cutting After Piercing

IMPORTANT: Do not lift rollers before beginning this step.

1 Insert the cutting blade.

2 Select the color for cutting line.

3 Change the pressure back to a normal cutting pressure.

4 Change the cut setting to Cut 4.

5 Click Start to cut.

Embossing With the Creative Cutter
The Creative Cutter can emboss metal foils, vellum, and suede. It cannot emboss cardstock. 
Some materials require two passes to gain the effect you want. The Creative Cutter embossing 
kit comes with the embossing tool, two embossing tips, and one velvet embossing mat. 

You can just emboss an image or you can emboss and then cut around the embossed area. Use 
the procedures that follow.

Embossing an Image

1 Open any of the Creative Cutter images or create your design in Pazzles Creative Cutter. 
Because you are not cutting paper, you can choose images that have intersecting lines. 

2 Insert the embossing mat into the Creative Cutter. Use the same procedure as when you 
insert a cutting mat.

3 Lower the pinch rollers and press F4 to measure.

4 Press F1 until you see Pen Mode. Do not omit this step!

5 On the Cutting Control Panel in Pazzles Creative Cutter, set the pressure to approximately 
350 and the speed to Slowest. See figure 181.

6 Click Start to begin embossing. 
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Embossing and Then Cutting Around the Embossed Area

1 Create the embossing design in Pazzles Creative Cutter or use one of the images on the 
Creative Cutter CDs.

2 Add an outline. Be sure to assign different colors to the outline and the embossing lines. See 
figure 180.

Figure 180

3 Insert the Embossing tool.

4 Place the material to be embossed on the plush embossing mat.

5 In the Cutting Control Panel, click the box with the embossing color. The screen display 
changes to show only embossing lines. See figure 181.

Figure 181

6 Verify that the Advance box is clear (not checked).

7 Click Start to begin embossing.

IMPORTANT: Do not lift the pinch rollers when embossing is complete.

8 Remove the embosser and insert the cutting blade.

9 Click the box with the outline color. This changes the display to show only cutting lines.

10 Click Start to begin cutting the outline.
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Engraving With the Creative Cutter
The Creative Cutter can engrave the following media:

• Metals

• Metallic cardstock

• Mirror cardstock

• Glass

• Plastic

• Wood

• Heavy cardstock (enhance the engraving with walnut ink) 

You can just engrave an image or you can engrave and then cut around the engraved area. In 
addition, you can color in sections of your drawing or engravings to create a solid or textured 
look. Use the procedures that follow.

Kit Contents

The Creative Cutter engraving kit comes with a silver or gold metallic mat for use when 
engraving on objects such as dog tags and pre-cut tags.

Engraving an Image

IMPORTANT: Do not overtighten the thumbscrew during insertion.

1 Import any of the images on the Creative Cutter CDs or create your design in Pazzles 
Creative Cutter. See “Find and Import an Image” on page 35. For instructions on how to 
IMPORT your image. Because you are not cutting paper, you can choose images that have 
intersecting lines. 

2 Place paper, foil, or wood sheet on a regular cutting mat. 

3 Insert the project on the mat into the cutter.

4 Lower the pinch rollers and press F4 to measure.

5 Press F1 until you see Pen Mode. Do not omit this step!

6 On the Cutting Control Panel in Pazzles Creative Cutter, set the pressure to approximately 
300. 

7 Set speed to slowest.

8 Click Start to begin engraving. If the engraver drags lines, try decreasing the pressure.
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Engraving and Then Cutting Around the Engraved Image

1 Open any of the Creative Cutter images or create your design in Pazzles Creative Cutter.

2 Add an outline. Be sure to assign different colors to the outline and the engraving lines.

3 Insert the engraver.

4 In the Cutting Control Panel, click the box with the engraving color. The screen display 
changes to show only engraving lines. See figure 180 on page 130.

5 Verify that the Advance box is clear (not checked). See figure 181.

6 Click Start to begin engraving. 

IMPORTANT: Do not lift the pinch rollers when engraving is complete.

7 Remove the engraver and insert the cutting blade.

8 Click the box with the outline color. This changes the display to show only cutting lines.

9 Click Start to begin cutting the outline.

Coloring Section of Engravings

1 Use the Select Elements tool to select the part of the image to be filled in.

2 Under the Tools menu, click Engraving and then click Inside. The Engraving Fill window 
opens.

3 Click in the Tools box and type a value of 0.10 or less. For a solid fill, type 0.02. See 
figure 182.

4 In the Fill box, select the type of fill you wish to apply: Sweep, Line, or Island.

5 Click OK. The selected part of the image fills with the most recently used line color. To 
change the color, select the lines and right-click on a color square on the Color Palette 
window.

Figure 182



Chapter 7 Specialized Cutting and Finishing Techniques

Creative Cutter PRO 133

Engraving on a Metal Plate, Dog Tag, or Wood Tag

TIP: Practice with paper tags first.

Step 1: Prepare the File

1 Scan the object or a tracing of the object’s outline into Pazzles Creative Cutter. Scan at 300 
dpi as a black and white bitmap.

2 Use automatic vectorization to convert the bitmap to cutting lines. See “Converting and 
Vectorizing Graphics” on page 110.

3 Save the resulting engraving guide as a file.

Step 2: Prepare the Engraving Guide

1 Open the engraving guide in Pazzles Creative Cutter.

2 Place the guide image at least 3" down from the top of the page and about 1/2" the left edge.

Figure 183

3 Type or add your engraving image inside the guide.

4 Assign a different color to the inside design. To do so, click the Palette icon, click Inside, 
and right-click on a color square in the Paint Palette window.

Figure 184
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Step 3: Engrave the Object

1 Place the engraving mat (either silver or gold) in the cutter, using the same procedure as for 
the cutting mat. See “Working With the Cutting Mat” on page 17.

2 In the Cutting Control Panel, click the color square for outlining the object to be engraved.

3 Etch the outline into the cutting mat. Do not lift the pinch rollers.

4 Attach the engraving object over the outline, using a strong tape such as two-sided carpet 
tape. Leave the pinch rollers down.

IMPORTANT: Engrave on slowest speed. Make sure PEN MODE is selected on the cutter!

5 In the Cutting Control Panel window, select the square with the engraving color.

6 Click Start to begin engraving. 

Using the Creative Cutter Pen Tool 
The Creative Cutter pen tool is designed to work with Sakura Gelly Roll pens.

Step 1: Insert the Pen Into the Holder and Into the Cutter

1 To insert the pen into holder, loosen the white thumbscrew and push a Sakura Gelly pen all 
the way in. Note that some pens are slightly thicker than others but become easier to insert over 
time. If the pen is difficult to insert, try rubbing it with sandpaper to wear it down a bit.

2 Insert the pen holder into the carriage of the Creative Cutter, using the same opening as for 
the bladeholder.

3 Verify that the lip of the pen holder is seated flush to the opening.

4 Tighten the black thumbscrew to secure the pen holder in place. 

IMPORTANT: Do not overtighten the thumbscrew.

Step 2: Using the Pen

1 Open any of the Creative Cutter images or create your design in Pazzles Creative Cutter. 
Because you are not cutting paper, you can choose images that have intersecting lines. 

2 Place paper on the cutting mat and insert it into the cutter.

3 Lower the pinch rollers and press F4 to measure.

4 Press F1 until you see Pen Mode. Do not omit this step.

5 Open Cutting panel in Pazzles Creative Cutter and set the pressure to approximately 100.

6 Set the speed at Slow or Medium. 

7 Click Start to begin drawing. If the pen drags lines, try decreasing the pressure.
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Filling in Sections of the Drawing

You can color in sections of your drawing to create a solid or textured look.

1 Use the Select Elements tool to choose the part of the image to fill in.

2 Under the Tools menu, click Engraving and choose Inside.

3 In the Tools box, choose a value of 0.10 or less. Use 0.02 for a solid fill.

4 Select the Fill style: Sweep, Line, or Island.

5 The Fill color will be the color most recently used for line color. To change it, select the 
lines and right-click on a color square in the Color Palette window.

Figure 185

Creating a Drawing With Multiple Colors

1 Create the design in Pazzles Creative Cutter or use one of the Creative Cutter images.

2 Add an outline. Be sure to assign a different color to the outline that you will use for 
cutting.

3 Change the colors of detail lines to correspond to various pen colors.

4 Insert a pen into the pen holder.

5 In the Cutting Control Panel, click the box with the color that corresponds to the pen color. 
The screen display changes to show only lines of that color. See figure 180 on page 130.

6 Verify that the Advance box is clear (not checked). See figure 181. 

7 Set the pressure to 100.

8 Click Start.
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Change the Pen Color and Cut

1 When the first color drawing is finished, do not lift the pinch rollers. Remove the pen by 
loosening the white thumbscrew.

2 Insert the next pen and repeat steps 5-8. Continue the same process for all colors.

3 When all color drawing is finished, do not lift the pinch rollers. Remove the pen holder and 
insert the cutting blade.

4 Cut the image: First, click on the box with color for outline to display only cutting lines. 
Reset the pressure, and then click Start.

Figure 186
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8 T r o u b l e s h o o t i n g  G u i d e

This chapter provides information on solving problems that have been encountered by some 
Creative Cutter users. Please consult this chapter before calling Support.

Troubleshooting Tips 

Issue Possible Causes and Remedies

You want to work in Pazzles 
Creative Cutter while cutting

Open another Pazzles Creative Cutter. You can cut and paste between 
the two.

HPGL Error #1 message appears This usually is a minor error that occurred when the pinch rollers were 
raised before the cutting job was finished. 

Clear the memory by turning off the cutter, waiting a moment and 
turning it back on again. Set the machine to Cut 4 and then press the 
Next button on the cutter. Try the job again.

If the problem persists, check all connections between the cutter and 
the computer.

Paper End Error Appears on your 
LCD Screen

Your back sensor has come uncovered. If this occurs, please recover 
your back sensor with two strips of overlapping black electrical tape, 
and one strip of silver duct tape. This will ensure that no light reaches 
the sensor, thereby eliminating the Paper End Error.
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How to uninstall and reinstall the 
program

Step 1: Note and record the current port settings. Click SETTINGS and 
then click Plotter Codes.

Step 2: Remove all Pazzles Creative Cutter registry files

If you have saved any file within the Pazzles Creative Cutter program 
in the Image folder, save them in another location before beginning 
this procedure!

1. Point to Start at the bottom-left corner of you computer screen, and 
click All Programs.

2. Click Pazzles Creative Cutter, click Tools, and then click Pazzles 
Creative Cutter Registry.

3. In the box that appears, select and delete all registry files.

Step 3: Unistall the Pazzles Creative Cutter program

1. Open your Control Panel on your computer, then go to Add/
Remove programs.

2. Click Pazzles Creative Cutter Creative Cutter 2005, and then 
click the remove button to the right of it.

Step 4: Delete the Signmax and Pazzles Creative Cutter folders

1. Point to Start and then click My Computer.
2. Select the C: drive and click the folder named Program files. (If 

you get a message about hidden folders, select to see hidden 
folders).

3. In the Program Files folder look for a Signmax folder and delete 
it.

Step 5: Search and delete other files

1. Close all windows until you return to your Desktop screen. Then, 
point to Start and click Search.

2. Select to search all files, type Pazzles Creative Cutter in the box, 
and click Search.

3. Delete any files found.
4. Repeat the search process, typing Signmax in the box. The only 

folder you should see is the Signmax folder in the Recycle Bin.

Step 6: Reinstall the program

1. Use the directions in Chapter 2.
2. After installing, re-check the registry files. Delete any you find
3. Restart the computer. The registry files will rebuild.
4. In Pazzles Creative Cutter, set up the driver and port. See Chapter 

2.

Issue Possible Causes and Remedies
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HPGL Error #3 message appears Verify that all cords between the computer and the cutter are securely 
connected. Try cutting again.

Check type of connection you are currently using. If you are using a 
parallel cord, it will be likely to be the problem. Replace with a USB to 
serial converter. See “What To Do If You Don’t Have a Serial Port” on 
page 9

If the problem persists, uninstall and reinstall the program. Use the 
following procedure:

Step 1: Note and record the current port settings. Click Settings and 
then click Plotter Codes.

Step 2: Remove all Pazzles Creative Cutter registry files.

1. Point to Start at the bottom-left of your computer, and click All 
Programs. 

2. Click Pazzles Creative Cutter, click Tools, and then click Pazzles 
Creative Cutter Registry. 

3. In the box that appears, select and delete all registry files. 

Step 3: Uninstall the Pazzles Creative Cutter program

1. Point to Start and then click All Programs.
2. Click Pazzles Creative Cutter, and then click Uninstall. If 

prompted, choose to delete all shared files.

Step 4: Delete the Signmax and Pazzles Creative Cutter folders.

1. Point to Start and then click My Computer. 
2. Select the C: drive and click the folder named WINDOWS. (If you 

get a message about hidden folders, select to see hidden files.)
3. In the Windows folder, click the Program Files folder to open it. 

Click and delete the Signmax folder. 

Step 5: Search and delete other files

1. Close all windows until you return to your desktop screen. Then, 
point to Start and click Search.

2. Select to search all files, type Pazzles Creative Cutter in the 
box, and click Search. 

3. Delete any files found.
4. Repeat the search process, typing Signmax in the box. The only 

folder you should see is the Signmax folder in the recycle bin.

Step 6: Reinstall the program. 

1. Use the directions in chapter 2.
2. After installing, re-check the registry files. Delete any you find.
3. Restart the computer. The registry files will rebuild.
4. In Pazzles Creative Cutter, set up the driver and port. See 

chapter 2.

Issue Possible Causes and Remedies
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The program aborts or generates a 
run-time error

Generally there are a few very common reasons for a runtime error. All 
of these are easily avoidable once you know what they are.

Issue: You are using software version Letter 14.0 and are trying to open 
files for version 2005. 

Solution: Make sure you open the cutting file folder that says 12.0 or 
14.0.

Issue: You are using software version Letter 2005 and are trying to 
open files created in an older version of the program. 

Solution: If your files are not in a folder marked _05, they are in the 
old version. You must import those files into the 2005 version. See 
instructions on our Web site at www.pazzles.com.

Issue: You are trying to outline and you chose multiple outlines.

Solution: Three is the maximum safe number of outlines. After three, 
click on the outermost outline and do the outline function again.

Issue: You are trying to outline and you have chosen TOO large of an 
outline.

Solution: Reduce the size of the outline.

Issue: The memory in your computer is full. The program tries to 
remember every move you make so that you can use the Un-Do 
function.

Solution: Clean the memory by going to HELP and choosing Clean 
Memory, OR go to the Setting menu and select SET UP. On the 
Document page, click Undo and change the number of saved steps to 
10 or fewer.

Issue: Errors occur when you have open paths. These are points next to 
each other that should be joined.

Solution: Use the Show Open Paths tool to find the problem. It 
appears on the bottom of the toolbar on the right side of the screen. It 
has a question mark beside a line with two dots. Then close the open 
paths with the Join two points tool. See “Break and Move Tool” on 
page 103 and “Join Two Points Tool” on page 104.

Issue Possible Causes and Remedies

http://www.pazzles.com
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The program aborts or generates a 
run-time error

Issue: You are using the Sort Inline before Outline function. 

Solution: Check to see if you have circles or ovals made with the Draw 
tool. These objects have no beginning or end point. Apparently, this 
confuses the program! See “Break and Move Tool” on page 103. 
Create some points on them by using the Break and Move tool. See 
“Break and Move Tool” on page 103. 

Issue: You have too many programs running in the background. They 
are all using memory to one degree or another. There is not enough 
memory to execute a function and you can get a runtime error.

Solution: Close background programs that are not necessary. 
Especially check the icons in the lower-right corner of your desktop 
screen. These tray icons mean that the program is running at least 
minimally in the background. Usually you can right click on the icon 
and bring up a menu that will allow you to shut them off. Common 
ones that seem to be default with Windows are QuickTime, AOL, 
Outlook Express, and some scanners and printers.

Out of pinch error appears. The arrows on the pinch rollers are not lined up correctly. See 
chapter 2.

Start and stop points do not meet Make sure the machine is set to CUT 4.

Decrease pressure.

Check the cutting mat. It might be warped or in need of cleaning. 
Remove small bits of lint from the mat.

Move the cutting start point (use the Shape menu).

Paper shoots out from under 
wheels

The adhesive covering the back sensor is loose or is letting in light. 
Reapply the adhesive.

The cutting project is beyond allowable margins. Move the project to 
within limits or use a larger mat.

Project or page size is bigger than the paper size. 
Check the Panels box on the Cutting Control Panel. If you see 101, 202 
etc. your project is larger than 12x12. If you are cutting paper bigger 
than 12x12, change the material size in the Cutting Control Panel (for 
example, for 15" paper, change the material to 15.000)

You were cutting a larger page, switched to a smaller paper, and forgot 
to move the wheels to fit the smaller page. If this is the case, move the 
wheels.

The silver rod that helps to grip and move the paper might be dirty. If 
so, use Undo SPARINGLY on a toothbrush to scrub off.

Issue Possible Causes and Remedies
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Projects do not cut completely Pressure is too weak: increase it. DO NOT BE AFRAID TO 
INCREASE THE PRESSURE TO 300+!

The mat is drooping due to paper weight or humidity. Place a small box 
directly behind the cutter to keep the mat flat or use our Creative Cutter 
platforms. 

Cutting project is outside of allowable margins. Move it or check page 
settings.

There is a communication error between machine and computer (often 
an HPGL #1 error). Restart both and check cord connections.

The paper buckles The pressure is too high. Reduce it.

The cutting speed is too high. Reduce it.

The cutting mat needs more adhesive. 

Paper or material is hard to hold. See mat instructions for pinch roller 
placement.

Cutting project is distorted Usually this happens only at the edge of paper at the back of the cutter. 
This kind of error means the paper is buckling or that the project is just 
outside the allowable margin. Also check to see that the mat is not 
bumping something near the cutter as it moves back and forth.

Sharp angles do not cut well Reduce the cutting speed.

Reduce the pressure. Setting the pressure too high pushes in the 
corners instead of cutting them.

Round the corner: use the Break and Move tool to change the point 
into a curve. See “Break and Move Tool” on page 103 and “Cutting 
Around Tight Corners” on page 126.

When cutting an object inside of 
another shape the shape pops out 
and gets caught on the cutting 
blade

You need to change the cutting order so that the smaller inside piece is 
cut first.

1. Select the object or project with Select Elements tool. Be sure to 
select all parts by dragging box around object or by choosing Select 
All under Tools menu.

2. On the Tools menu, click Sort Inline path before Outline under 
Tools menu.

Your project requires that you cut 
smaller pieces of paper

You can cut smaller pieces down to about 4" in length. Be sure to place 
the left roller wheel under the middle arrow and the right wheel within 
the yellow line. Also, check the width of the paper and ensure that the 
rollers do not go off the back edge of the paper while cutting. See 
“Pazzles Logo Mats.” on page 18.

Issue Possible Causes and Remedies
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You want to position the paper so 
that it will cut in the same place 
each time

Be sure that the box by Advance in the Cutting Control Panel is NOT 
checked!

Usually you will start cutting your project with the paper extending 1" 
in front of the wheels. This is in the middle of the gray cutting strip. 
You can use a permanent marker to draw some lines to help with 
alignment. Or, if you are using the cushioning strip, you can make your 
marks in it. 

You’ve lost changes to a project Save, save, save! Saving a project in Pazzles Creative Cutter is as 
simple as saving in any other Windows-based program. Select Save or 
Save As under the File menu. Create an appropriate folder for your 
projects (usually in My Documents), give your project a name, and 
click Save. Save often!

You must cut the same project 
multiple times and you want to 
continue working on the computer

Press the F4 button and then press the Copy button on the Creative 
Cutter to repeatedly cut the same project. This allows you work on 
another project on your computer while cutting. Be sure that the 
Advance box in the Cutting Control Panel window is clear (no 
checkmark).

You encounter problems while 
cutting thick materials 

When cutting thick materials such as wood, metal, and felt, you might 
need to cut two or three times to get completely through. You can set 
the machine to cut several times in the same place. Select the image 
you want to cut, being sure to select inside parts too, and right-click 
with the mouse. On the menu that appears, select Duplicate. This will 
place a copy directly on top of the original. This can be done several 
times if necessary.

You want to cut over the same 
lines because the lines did not cut 
clearly.

• Use the Duplicate function (see see “You encounter problems while 
cutting thick materials” on page 145).

• Press the Copy button on the Cutter panel. Do not lift the pinch rollers 
and verify that Advance is not checked in the Cutting Control Panel.

• Press Start again in the Cutting Control Panel. Do not lift the pinch 
rollers and verify that Advance is not checked

Vectorized drawings have stray 
lines, double lines, or just look 
like a mess

Use the procedures in “Tools and Tips for Cleaning Up Vectorized 
Images” on page 111.

You want to save a project you 
have created

DO NOT save files in an Images folder within the cutting program!

Save all files in MY DOCUMENTS. This will prevent any loss of files 
if you need to reinstall the program.

To save: Go to File, Save As, Save In: My Documents/Your Folder

Issue Possible Causes and Remedies
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